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1. Introduction 

NextFEM Designer is a user-friendly Finite Element Analysis program, which can be used alone or to be a pre- or post- 

processor for several widely used FEM programs (i.e. OOFEM, SAP2000, Midas GEN, OpenSees, ABAQUS/CalculiX, 

Zeus-NL, and others).  

The most important features are: 

- general pre-processor capabilities: 3D and 2D views, customizable colours, accelerated rendering with 

DirectX technology; 

- modelling with the most common structural elements, such as beams, shells and solid elements of first and 

second order; 

- all kind of static and dynamic, linear and non-linear analyses, including Modal, Response Spectrum, 

Buckling, PDelta, non-linear thermal; 

- importing input files from more than 20 proprietary format; 

- importing results from more than 20 proprietary and non-proprietary format; 

- exporting models more than 20 proprietary and non-proprietary format; 

- post-processing capabilities with deformed shapes with contour display, beam diagrams, stress and strain 

contour. 

1.1. Editions of NextFEM Designer 

NextFEM Designer is available in the following editions: 

­ standard version, that can be downloaded from nextfem.it, having all the features described in this manual; 

­ Lite version (up to v2.4 – end of 2024), available only on Windows Store® for Windows 10® users. Such 

edition does not accept license codes and the following features are not available: 

o analysis on cloud; 

o manuals for dedicated modules. 

In this last edition, not all the features covered in this manual are present. 

1.2. Installing NextFEM Designer 

NextFEM designer is designed to work with Windows 10 or above and it is available for 64 bit Windows versions. The 

prerequisites are: 

- .NET Framework 4.8; 

- VC++ 2022 redistributable package. 

To manually associate the NXF files to NextFEM Designer, open it once as administrator (right click/Run as 

administrator … ) 

 

1.3. License Activation 

To activate the program, you must be connected to the Internet at the first run. For the licensed installation, please 

refer to the command ?/License… . 

 

1.4. Manual and Support 
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Along with NextFEM Designer is provided the user manual which describes the main controls and procedures to get 

started with the program.  Moreover, online support is available. It is possible to ask questions or give suggestions in 

the dedicated part of the NextFEM forum (www.nextfem.it/it/nextfem-designer-support-forum/).  

1.5. User interface 

Display window looks like the figure below. It is possible to show the model (extruded or not), number of nodes or 

element, loads applied, global axes and other properties of the opened file. On the bottom left corner, number of 

nodes and elements of the model are shown. 

 

NextFEM Designer user interface presents a menu bar on the top which contains all the commands that can be 

used. Moreover, other toolbars, that can be anchored aside the viewport, which contain the major commands are 

available. A toolbar can be added in the main window by clicking the button 3 of the mouse (see User Controls 

chapter) and check it. 

 

The following toolbars are available: 

- File 

 

- Edit 

http://www.nextfem.it/it/nextfem-designer-support-forum/
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- View 

 

- Draw 

 

- Assign 

 

- Tools 

 

- Plugins 

 

- Results 
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2. Modelling with NextFEM Designer 

2.1. User controls 

Mouse usage 

 

- 1 Button one permits to select objects in viewport by: 

o Single object selection: clicking on nodes or elements; 

o Window selection: by pressing and holding down the button, elements can be selected. 

Dragging the mouse from left to right only elements and nodes entirely contained in the 

window are selected. Dragging the mouse from right to left every element or nodes that 

intersect the window will be selected. 

- 2 Button two (the mouse wheel) has a double function. Holding down it and moving the mouse, the 

model moves; scrolling it, zoom changes. 

- 3 Holding down the button three, the model rotates. 

Keyboard shortcuts 

Esc clear current selection 

Canc delete selected nodes and elements 

Alt+A save screenshot 

Alt+B check linear element mesh 

Alt+C 
assign random colors to sections and paint 
the model 

Alt+E close the program 

Alt+F use built-in solver 

Alt+F4 close the program 

Alt+G open Groups mask 

Alt+H open Select by name / number mask 

Alt+I invert selection 

Alt+J show Select by property mask 

Alt+M show/hide menu bar 

Alt+O switch to OpenSees solver 
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Alt+R Run the model 

Alt+Shift+R Select cases to run and launch them 

Alt+Shift+L Show/hide local axes 

Alt+Shift+K modify the model without losing results 

Alt+Shift+M 
Import model and results from Midas 
programs via API 

Alt+Shift+S merge selected beam by selected nodes 

Alt+Shift+U 
merge meshed beams and imported 
results 

Alt+S copy screenshot 

Alt+V open views control 

Alt+0 set view in 3D 

Alt+1 set view in XY plane 

Alt+2 set view in XZ plane 

Alt+3 set view in YZ plane 

Ctrl+0 Open Smart checking window 

Ctrl+1 Steel checking as per Eurocode 3 

Ctrl+2 
Steel checking for scaffolds as per EN 
12811-1 

Ctrl+3 
Aluminium alloy checking as per Eurocode 
9 

Ctrl+4 
Aluminium alloy checking for scaffolds as 
per EN 12811-1 

Ctrl+5 Timber checking as per Eurocode 5 

Ctrl+6 Concrete checking as per Eurocode 2 

Ctrl+7 Masonry checking as per Eurocode 6 

Ctrl+A select the entire model 

Ctrl+C Copy selected objects 

Ctrl+D deselect all nodes 

Ctrl+F2 hide selection 

Ctrl+E export model 

Ctrl+F Fire checking 

Ctrl+G open Verifications window 

Ctrl+I import model 

Ctrl+K show loads 

Ctrl+L set contour limits 

Ctrl+N new model 

Ctrl+O open a model 

Ctrl+Q open Query dialog 
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Ctrl+R show results 

Ctrl+S save the model 

Ctrl+Shift+S same model as 

Ctrl+U update program (including minor updates) 

Ctrl+V Paste selected objects 

Ctrl+W 
integrates the selected section cut (only 
when results are displayed) 

Ctrl+X Cut selected objects 

Ctrl+Y redo operations in the model 

Ctrl+Z undo operations in the model 

Ctrl+"+" 
auto-dimension rebar in concrete 
members 

Shift+MouseR open context menu 

F1 open the user’s manual 

F2 show selection only 

F3 show view options 

F4 show the entire model 

F5 show/hide nodes 

F6 activate/disable extruded view 

F7 show node numbers 

F8 show element numbers 

F9 show nodal masses 

F10 show values in beam diagrams 

F11 show values in displayed loads 

F12 show constraints in the model 
 

Command line options 

The following command line options are available: 

- (-i filename.ext) allows to import a file specifying filename; 

- (-c nodes)  checks for free nodes in the loaded model; 

- (-c elems)  checks the counter-clockwise element connectivity in the loaded model; 

- (-e filename.ext) allows to export the open model specifying filename, according to the specified 

extension ext. 

Available formats are: 

o “.s2K”: SAP2000 text file; 

o “.mgt”: Midas GEN text file; 

o “.dxf”: DXF drawing file; 

o “.tcl”: OpenSees script; 

o “.inp”: ABAQUS/CalculiX input deck;  

o “.in”: OOFEM input deck; 

o “.dat”: ADAPTIC / Zeus NL input deck;  

o “.txt”: Straus7/Strand7, versions higher than 2.2; 

o “.ifc” and “.ifcxml”: IFC4 file format for BIM; 

o “.xml”: SeismoStruct and WinStrand model.  
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- (-d lc data item dir)  : extract data from the result file loaded and save selected output in CSV format; 

the following flags are currently supported: 

o lc: Loadcase name; 

o data: data type to be extracted: “react”, “disp” or “solls”  for  reactions, displacements or beam 

forces, respectively; 

o item: number of node/element or "all" for the sum for all nodes/elements. Optional, “all” is 

default; 

o dir: direction 1 2 3 4 5 6, according to global conventions (for nodes) or local ones (elements). 

Optional. 

- (-r) : run the loaded/imported model 

- (-s [filename.ext] ) : save the loaded/imported model 

- (-p) : print the model report in PDF format 

- (-x) : closes the program after the batch operations as per any of the previous commands. The flag “-d” 

does not need this because it exits anyway. 

2.2. Local axis conventions 

The following conventions are adopted for elements. Keep in mind that all the output forces/stresses/strains such as 

beam diagrams or area stresses are plotted with the following conventions along the local element axes. 

 

Beams 

For horizontal and subvertical elements, the second axis is always vertical and coincident with global Z. For vertical 

elements, the second local axis (“y”) is parallel to global X.  

 

 

Sections for monodimensional elements 

 

Planar elements 
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Solid elements 

 

Section cut 

 

2.3. File menu 

 New:  Opens an empty model 

 Open:  Opens an existing model 

Save:  Saves the model currently opened 

 Save as: Saves the model in *.nxf or *.xml formats. 

- *.nxf is a proprietary file format; 

- *.xml saves the model in plain XML-formatted text.  

 Close: Closes the model currently opened. 

Import: Imports model from other formats. See chapter 3 for supported formats. 
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Merge: Imports model from other formats merging it with the one in use. 

Import OpenSees results: Imports OpenSees recorders 

 

By the box Select results to be imported it is possible to import all the output files generated from the procedure007.tcl 

routines, that are included in the program. All the file with extension .out must be in the same folder of the already 

imported TCL model. 

By the box Generic recorder it is possible to import a generic result by specifying its type. If the flag “ -time” is used in 

the recorder, select the proper checkbox. The recorder file must be in the same folder of the already imported TCL 

model. 

 Import additional datasets: Imports additional datasets defined by user. This command is particularly suitable 

for importing data from external programs (i.e. OpenSees custom recorder). From the dropdown menu it is possible 

to import: 

- User data: the format for such data is: 

node (node numbers series, separated by spaces, tabs or semicolon) 

time (series of data related to nodes, in the same order of the node numbers series in the first line) 

 

or 

 

element (element numbers series, separated by spaces, tabs or semicolon) 

time (series of data related to nodes, in the same order of the element numbers series in the first line) 

 

Such data will be imported in a new loadcase with the name of the source file, or with a temporary name if 

data are pasted in the textbox. All data can be saved in the NXF file and will be displayed in Node data or 

Element data results views. 

- Midas GEN results: it allows the import of results tables from Midas GEN® (command Results/Result tables 

inside GEN). Tables can be pasted directly in the textbox. Supported tables are: Beam Forces, Wall Forces, 

Node Displacements. 

- Straus7 results: imports results tables from Straus//Strand7, see ImportExport module manual; 

- SismiCAD combinations: imports the file containing the combinations from SismiCAD, see ImportExport 

module manual. 
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Export: Exports the model in many formats. 

 Exit: Closes the program. 

2.4. Edit menu 

Undo:  Undo the last action. 

Redo:  Redo the previous action. 

Material: To define materials properties: 
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- To add a new predefined material, click on the Material library combo box to show the available 

materials. Then select a material from the lower box and click on Pick  to choose one of them; 

- To add a new customized material, click the Add user material button 

The following quantities are required: 

­ Name of the material 

­ (optional) reference code 

­ the Young’s modulus E 

­ the Poisson’s ratio n 

­ the shear modulus G (can be calculated automatically by clicking on Shear modulus from E and G) 

­ the characteristic strength fk (for elastic material behaviour) 

­ thermal expansion coefficient alphaT 

­ weight density Wd 

­ Mass density Md (can be calculated automatically by clicking on Mass density from weight density) 
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 Click the Assign to selected elements to assign the selected material properties to the elements. 

 Click the button Cancel to exit this form. 

Once the drop-down menu Tools has been selected, it is possible to choose between the following commands: 

- With the command Shear modulus from E and n it is possible to get automatically the shear modulus G, 

computed through the following equation: 

- 2(1 )

E
G


=

+  
- With the command Mass density from weight density it is possible to obtain automatically the mass density 

by dividing the weight density by the gravity acceleration, with is considered with consistent units. 

- The button Heat transfer settings permits to specify the laws of variation of density, conductivity and 

specific heat on the base of temperature. 

- With the Set stiffness factor command it is possible to set the stiffness factor to be considered for the current 

material. 

To add a new value in table for material checking, use the button Add once the textboxes Custom field and Value 

have been compiled. 

  WARNING: it is strongly advised to insert units consistent with the initial choices (see Edit > Set units). 

Sections:  to add Planar or Beam sections. 
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- To add a planar section, specify the name and the thickness in the Planar section boxes and then press 

Add planar section; 

- To add a beam section, click the Beam section drop-down menu and choose the type among 

Rectangular, C-shape, Circular, Pipe, Box, By point options. 

 

Click the Assign to selected elements button to assign the selected section to the selected elements. 

The built-in beam sections available are: 

 

Further section shapes are available: Omega and cold-formed non-thin-walled C shapes, that can be set 

from inside the section properties. 

Other custom libraries can be present in this list. For each of them, the following mask will be displayed to 

allow selection. Several libraries for steel sections are included in the program. 
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To see the properties (area and moments of inertia) of the inserted sections select a section and press the 

Edit properties button. This mask allows also to import a section from DXF file and define a section by points 

or by composing single figures. 

  

 WARNING: it is strongly advised to insert units consistent with the initial choices (see Edit > Set units). 

In the Add figures and By Points masks, it is possible to edit the component shapes of the section (for both voids and 

solids) or import a section from DXF with the Import DXF command. The contours of each figure must be polylines, 

defined clockwise for solids and anticlockwise for voids. 

 WARNING: the insertion of figures in sections does not take place in absolute co-ordinates, as the centre of 

gravity is recalculated for each change. 

In the Properties mask it is possible to specify the design properties of the section to be used during checking. For 

sections without a defined type (e.g. point sections, customised), a class is not automatically assigned to the section 

during the verification for steel or aluminium material. For this, the user is asked to specify the class of the section 

via the Add Property drop-down menu, which presents the following options: 
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− Steel verification adds the following data for verification: SectClass (section class), alphaLT (coeff. flexural-

torsional buckling), alphay (coeff. buckling around y-y), alphaz (coeff. buckling around z-z), Jw (warping 

constant) 

− Aluminium verification adds the following data for verification: SectClass (section class), Jw (warping 

constant) 

− Composite column adds the following data for analysis: Ec_factor (factor for the elastic modulus in the 

calculation of the homogenisation coeff., default at 0.5) and Reduction_factor (default at 0.9, inertia 

reduction factor) 

− Composite beam adds the following data for analysis: Factor_Mpos (factor for positive moment inertia) and 

Factor_Mneg (factor for negative moment inertia) 

− Cold-formed section adds the following data for the verification of thin sections, which is not performed 

without these flags: CF_tw (section thickness) and CF_rc (radius of curvature between segments) 

− Fibre section adds the following data for the analysis in OpenSees: fibersX (number of fibres in the z-

direction of the section) and fibersY (number of fibres in the y-direction of the section) to specify the fibre 

division for each direction 

− Skip verification adds the flag skip = 1 to skip the verification of the section 

− From text allows the loading of a set of user-defined flags, which are reported as variables in the 

verifications. The file must contain one variable per line in the format nameVar=value. This is particularly 

useful for defining different thicknesses in thin sections, for example for a model in mm and a section 

consisting of 3 figures (which in the case of a thin section are series of segments): 

 

CF_tw=2 
CF_rc=2 
CF_tw_1_3=3 
CF_tw_1_4=2.5 
CF_tw_1_5=2.5 
CF_tw_1_6=2.5 
CF_tw_1_7=3.5 
CF_tw_2_2=1.5 
CF_tw_2_3=1.5 
CF_tw_3_1=1.5 
CF_tw_3_2=1.5 
CF_tw_3_3=1.5 

 

 

 WARNING: by changing the sectional properties, the section will be converted in “Custom” type. Such 

operation is not reversible. 
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Composite sections 

The support for composite sections includes: 

- Beams with slab like in figure (a) and 

- Columns with coincident centres of gravity (b). 

 

 

 

A composite section is automatically detected when: 

- Two or more filled figures, one of them associated to a steel material and one to a concrete material; 

- Properties of the composite section are defined inside the mask Section properties / Properties in order to 

distinguish a beam or a column section. 

 

  WARNING: The effective width of the section Beff must be evaluate by the user as per current code of 

practice. 
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The stiffness of beam elements having such sections is evaluated as follows. With subscript s, steel properties are 

described, while the ones related to concrete have the subscript c. 

 

For beams, the moment of inertia for positive bending around the elastic neutral axis na is calculated as: 

( ) ( )
2 2

1
zc zc

z zs zs tot s tot c

s zs s zc c
tot

c zs zc

I A
I I A H y x x H y

n n

E n A y A y
with n and x H

E n A A

= +  − − + + − +

  + 
= = −

 +

 

The moment of inertia of the section for negative bending around the plastic neutral axis is equal to the inertia 

given by the steel section, as the concrete part is considered as cracked. 

As a whole, bending stiffness is estimated as per EC4 and as a function of the factors Mpos and Mneg which can be 

changed in the “Properties” input mask (figure a).  

 

(a)  (b)  

 

Hence, the resulting bending stiffness is: 

1z Mpos z Mneg zsI f I f I=  +   

The remaining properties for the beam section are all calculated by dividing the concrete contribution by n. 

 

For composite columns, once the factors Ec and R have been specified in the “Properties” mask (figure b), the 

inertial properties of the section are calculated as follows: 

; ; ;
yc yzczc

z zs y ys yz yzs

s

Ec c

I II
I R I I R I I R I

n n n

E
with n

f E

    
=  + =  + =  +    

     
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The remaining properties are all calculated by dividing the concrete contribution by n. 

 

Strength calculator 

By the Strength calculator  button it is possible to define the rebar in a RC section and to evaluate its flexural 

strength. 
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In Define material properties the base material is specified. 

The box Rebar position can be used to specify the rebar coordinates (eventually of rectangular shape by checking the 

option Rect. rebar and by specifying the base dimension of the plate in Rect. base). The rebar coordinates are input on 

the base of the section local coordinate system, by specifying the diameter and the associated material (that can be 

set or added by the command “…”).  The available materials should be customized by modifying or adding *.nfm files 

in data/design subfolder in the software installation directory. 

In order to insert strands for prestressed RC sections, it is possible to input the initial strand stress by activating the 

Strand  option and by inputting the stress in consistent dimensions. 

To obtain the resistant values of the section, specify the Design forces in the required units. By selecting the Elastic 

option, the response of the section is computed with elastic materials. By selecting Plastic, elastic-perfectly plastic 

laws are used for material behaviour. In the Results box, the results of the performed computation are reported, linked 

to the overlying graphs. 

The window allows also resistant domains calculations reduced by thermal action. The software will compute the 

strengths parameters of the section at the selected instant of time and thermal case, on the base of strengths 

reductions laws for mechanical and resistant features of base material and rebar, if present. 

The available options in this mask are: 

- Concrete non-linear behaviour allows to choose between parabola-rectangle and bilinear material 

behaviour for the concrete material. If a simple rectangular or circular section are present, the Confined 

concrete option is available in this menu, allowing to consider the confined part of the section inside 

stirrups. In this case, data in Stirrups tab are required. Spirals are not supported. 
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-  Allow concrete tensile strength can be enabled to activate the contribution of tensile strength of the base 

material; 

- Bilinear hardening ratio allows to specify the ratio between the plastic branch of rebar and their elastic 

modulus. In case of Steel or Aluminium base material, it specifies the hardening ratio to be used. 

- Steel class section sets the class of the section in case of Steel or Aluminium base material, i.e. if the section 

can be calculated in plastic field or not. 

- Confidence Factor (C.F.) sets the confidence factor for strength of base material and rebar. 

- n factor  specifies the value of the homogenization factor (modular ratio between steel and concrete). The 

default is 15. 

Stirrups tab helps to define the stirrups for the current section and to obtain a resisting strength for both direction of 

the section. 

 

Export Results contains options to: 

- plot the tension in the reinforcement bars, 

- to perform the calculation with a triangular fiber section 

- to change the accuracy of the calculation (recommended value 15, to be increased in the case of very thin parts) 

- delete the calculation cache, which is useful when changing reinforcement materials or bars to prevent the 

program from returning the same results as before when these materials were changed  

- export images of the analysed section or points of the resisting domain 

- export the section to DXF with the reinforcement 

- display the domain in 3D. 
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Beam elements allows the import of reinforcements from individual elements, temporarily overwriting those of the 

section. The Get forces button allows the stresses for the desired abscissa taken from the calculated model. 

 

 
 

Load cases: Inserts the linear static load cases by writing the Name box and then clicking on the Add button. 

Different load can be inserted without closing the Set load cases window. 

 

 WARNING: only linear static load cases can be inputted from here. 

From the Type drop-down menu it is possible to specify the type of base load case. This setting assumes importance 

in the automatic generation of load combinations, for which reference is made to the appropriate description of the 

command. 

The Add common loadcases button automatically adds the most used load cases (self weight, permanent, variable, 

etc.). 

Functions: Adds Time History (TH) or Spectrum functions by points or file. 
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From the dropdown menu in Series tools you can set several types of TH functions, such as: 

­ Eurocode 8 Spectrum: returns the design acceleration spectrum as defined in Eurocode 8 – EN 1998-1-1 

­ NTC2008 Spectrum: returns the design acceleration spectrum as defined in NTC2008 (Italian code of 

practice D.M. 14-01-2008). The program uses an automatic geo-referencing algorithm that allows to search 

for postal addresses finding the desired site. 

 

 
­ NTC2008 Wind Load: gives the wind action as per NTC2008 (Italian code of practice D.M. 14-01-2008) as a 

function of building height 

­ NTC2008 Snow Load: gives the snow load as per NTC2008 (Italian code of practice D.M. 14-01-2008) as a 

function of height of the building site 

­ Linear TH: returns a linear loading ramp 

­ Sinusoidal TH: returns a sinusoidal function on the base of the properties chosen by the user 

­ Calculated Spectrum: this option is enabled only if user has requested the acceleration spectrum of the 

displayed acceleration TH through the button View spectrum 
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­ From File: allows the user to load a 2-columns text file containing a data series 

­ Constant load: defines a constant loading plateau 

­ EC8 Seismic Forces: allows to define a set of static lateral forces for each rigid diaphragm defined as per 

EC8/NTC2008, to be used in an equivalent static analysis; 

­ EC1 Wind Load: wind load as per Eurocode 1 

­ EC1 Snow Load: snow load as per Eurocode 1 

­ EC1 Standard Fire Curve: fire curve as per Eurocode 1. The resulting series has time in seconds. 

­ EC1 External Fire Curve: external fire curve as per Eurocode 1. The resulting series has time in seconds. 

­ EC1 Hydrocarbon Fire Curve: hydrocarbon fire curve as per Eurocode 1. The resulting series has time in 

seconds. 

 Set units:  Custom user units can be defined by clicking on the opposite drop-down menu and choosing 

between: 

 
 

- Length: 

o Metres [m] (default option); 

o Centimetres [cm]; 

o Millimetres [mm]; 

o Kilometres [km]; 

o Inches [in]; 

o Feet [ft] 

- Force: 

o Newton [N]; 

o DecaNewton [daN]; 

o KiloNewton [kN] (default option); 

o KiloPounds-force [kipf] 

- Temperature: 

o Celsius degrees [°C] (default option); 

o Kelvin degrees [°K]. 

The following units are computed automatically in a consistent way: 

- Mass: 

o Megagram [Mg]; 

o Kilogram [kg] (default option); 

o Gram [g]; 

o Ton [t]; 

o Ounce [oz]; 

o Pound [lb]. 

- Stress: 

o MegaPascal [MPa]; 
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o KiloPascal [kPa]; 

o Pascal [Pa] (default option). 

 

 Check element connectivity: Checks counter-clockwise connectivity for elements with more than two nodes. 

 Check element overlap: Checks if there are some overlaid elements. 

 Check for free nodes:  Check whether every node is connected to an element. 

 Check element properties:  Checks if section and material have been assigned to each element. 

 Renumbering: Renumber the selected nodes and/or elements by the chosen criteria. 

 

Check line mesh: Check all the line elements in the model to find out is there are disconnected beams (or trusses). 

This command corrects the mesh by dividing the lines that present apparent intersections (i.e. a node belonging to 

one element that lies on the joining line of the considered beam or truss). 

 Nodes tools 

Merge overlapped nodes: Merges the nodes with the same coordinates in the whole model. 

 Move nodes: By selecting Move by increment, it moves the selected nodes of the specified quantity. By selecting 

Move to absolute position, it moves the selected nodes in the chosen directions to the specified position. 
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 Rotate nodes: Rotate the selected nodes with respect of a specified axis. 

To define a custom axis select two nodes in the model.  

 

Scale nodes: Scale the selected nodes (and elements) with respect to a specified point in the 3D space. 
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Mirror nodes: Mirror the selected nodes (and elements) with respect to a specified plane in the 3D space defined 

by 3 points. 

 

 Model info: add generic or custom model information to be used in the front page of reports. 

 

 Map location: set or change the location of the modelled building in the map. Latitude, longitude and elevation 

can be obtained by the address of the site. The parameter NorthY allows to specify the angle between the North 

direction and the Y global axis in the model. 
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 Mesh tools 

Mesh area: Automatically meshes an area into triangular elements. Choose the maximum area of the triangles 

to be generated, select the nodes of the perimeter of the area to mesh and then click on the Acquire 

selection button under the Filled areas section. To insert a hole in the mesh, select the nodes of the hole and 

then press the Acquire selection button under the Holes section. To confirm press OK. 

   

Options: 

− "Use quad elements where possible” combines triangles generated in pairs where possible into quad 

elements 

− When the option “Consider internal nodes” is selected, only the groups of nodes forming filled polygons 

are considered, even if non-convex.  

− The “Add external belt” option allows to mesh convex surfaces, extending them outwards for the desired 

length.  

− The “Prevent adding border nodes” option allows the creation of a mesh without adding nodes on its edge 

(e.g., flexible plane). 
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Tools: 

− The "Add internal nodes" button allows the selected nodes to be associated with the selected solid figure, 

forcing the nodes to be included in mesh (e.g. the base of columns in a slab). 

− The "Follow border beams" button allows a mesh to be created using a concave or convex contour created 

by the selected beams.  

− “Draw planar border” allows to draw on screen the border of the figure to be meshed.  

− “Nodes from planar elements” adds a path for each selected shell element.  

Add wall: The command allows to insert and mesh walls of arbitrary dimensions, made of Quad elements. 

To insert a wall insert the origin coordinates on the Origin box and specify its dimension on the Length and 

Height box.  

Enabling the Add upper cut/sloping option it is possible to insert sloping walls by specifying the Wall type 

and the angle of inclination (with angle [°] box). Clicking on the Wall type drop down menu the following 

options are available: 

- x; 

- y; 

- vertical that is in the working plane direction. 

x and y can be used only if the working plane is set as XY, otherwise they have no effect. 

Through the Drawing controls pan it is possible to move in the working plane to insert quickly adjacent 

panels.  

Enabling the Add openings option, holes can be added in the wall. 

 

Automesh wall: The command allows  to automatically mesh all the quad elements in the model, using 

the size specified in the Options under Size for IfcWall mesh. 

Mesh tapered beams: The command allows to automatically mesh all line elements of a model having variable 

cross section, i.e., different initial and final sections. 

 Expand macroelements: The command allows to automatically mesh all macro elements in a model, 

expanding them as specified by the submodels in the macro folder. 

 Add belt: The command allows to mesh both concave and convex belt, for example, on an existing slab. 
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Mesh volume: this command allows to mesh solids into tetrahedral elements. In Maximum size box the maximum 

characteristic size of the mesh element must be inserted; Minimum size sets the minimum characteristic size 

and Mesh grading sets the percentage variation of characteristic dimension amongst elements in target 

mesh. Press OK to mesh selected elements. 

Select STL if the volume is delimited by planar facets; select CSG is the volume is described by solid 

elements. 

 

Divide and merge: this command allows to divide in equal parts the selected line (2 nodes) and quad (4 

nodes) elements. Moreover, it is possible to merge the selected line elements having the same first local 

axis. Divide commands are available also for Quad and Hexa elements. 

 

Wall to frame: this command allows to obtain a frame from a shell wall model. This is particularly useful to 

convert into beams all the Wall elements imported from a Midas GEN® model or to apply plastic hinges to the 

beams obtained from walls. The local y axis of Quad element becomes the x axis of the beam. 

Extrude section: this command extrudes the selected beam elements accordingly to their transversal section into 

shell or solid models. This is particularly useful to convert a part of a frame into a shell or solid model to allow 

detailing analyses, such as local buckling. 

Change element type: This command allows changing the type of the selected elements. Pick a transformation 

from the menu and then press OK. 

 

The possible conversions are: 

- Truss->Beam: from truss to beam 

- Beam->Truss: from beam to truss 

- Beam->Beam3: from beam to 3 node beam (middle node) 
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- Beam3->Beam: from 3 node beam to beam 

- Spring->Beam: from spring to 2 node beam 

- Beam->Spring: from 2 node beam to spring 

- Quad->Tria: from quad to tria 

- Quad->Quad8: from quad to quad8 

- (planar)->PlaneStress: from planar element to plane stress 

- (planar)->Shell: from planar element to shell 

- (planar)->PlaneStrain: from planar element to plane strain 

- Tetra->Tetra10: from tetra to 10 nodes tetra  

- Hexa->Hexa20: from hexa to 20 nodes hexa. 

 

 WARNING: PlaneStress and PlaneStrain elements can be used only in XY plane. 

 

Extrude elements: this command allows to extrude elements from selected nodes, tria or quad elements. In 

all cases, the Extrusion direction and the Extrusion length must be provided by the user. 

  

If Node to beam is checked, the selected nodes will be extruded to beam elements. Remember to assign a 

material and a section to the obtained beams. 

If Tria to wedge is selected, the selected tria elements will be extruded to wedge elements. By checking 

Delete original elements, the initial tria elements will be deleted after extrusion. The material of newly 

created elements will be assigned equal to material of original tria elements. 

If Quad to hexa is selected, the selected quad elements will be extruded to hexa elements. By checking 

Delete original elements, the initial quad elements will be deleted after extrusion. The material of newly 

created elements will be assigned equal to material of original quad elements. 

 

Cut:  Cuts the selected elements (CTRL+X). 

Copy:  Copies the selected elements (CTRL+C). 

Paste:  To paste the copied/cut elements insert the shift coordinates in the opposite boxes and then click 

in Paste button (CTRL+V). 
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2.5. View menu 

 Select all:   Select all nodes and elements in the model. 

Invert selection:   Select the complementary elements and nodes to those that have been already selected. 

 Clear selection:  Deselect all elements and nodes. 

 Delete selected:  Delete the elements that have already been selected. 

Select group:  This command allows  to define group and to assign element and/or nodes to it. It permits also to 

select nodes and elements previously assigned to a group.  

To define a group, write its name in the Name box and press the Add button. To assign elements and nodes 

to each group select the group in the Active groups pan, select the nodes and the element to assign to the 

group and then click the Add selected nodes or Add selected elements button. 

 

To select nodes or elements previously assigned to a group activate the desired group in the Active groups 

panel and then press the Select nodes in group/Select elements in group button. 

To create a group of planar element that can hold reinforcements, use the commands in Wall design box. 

Select the planar elements and press Create wall for design. Automatically, 3 horizontal section cuts will be 

created (both ends and in the middle) to check the group by forces integration. To have vertical section 

cuts (e.g. floor spandrels), select Rotate section cut. To check slabs and avoid generation of section cuts, 

activate Consider as slab. The Not co-planar option allows to set groups of not aligned area elements. 

Select by name:  This command allows to select nodes and/or elements by name (ID).  The names must be written 

separated by a space. 
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Select by property:  By this option, elements can be selected by section, by material or by their type. 

- To select all the elements with the same section activate it in the Elements by section pan and the click 

the Select button. Press Unselect to deselect, Hide to hide them and Show to add them to the view. 

- To select all the element with the same material activate it in the Elements by material panel and then 

press the Select button.  

- To select all the elements of the same type such as Node, Line, Triangle, Quad, and so on, select the 

type(s) in the Elements by section pan and the click the Select button. 

 

Show all:   Shows all the elements and nodes in the model 

Show selection only:  Limits the view only to selected elements 

Hide selection:   Hides selected elements 

 Box pan/rotate:  Rotates the model avoiding the graphic regeneration of each element. To be used in old 

PCs. 

 Move: Move the model (pan command). 

Rectangle Zoom:  zooms the area selected by a selection rectangle 

Views:  Changes the view options. Choose between: 

  3D: Shows the entire model in a 3D view; 

  XY: Shows the model from the front in the XY plane; 

  XZ: Shows the model from the front in the XZ plane; 

  YZ: Shows the model from the top in the YZ plane; 

View nodes:  Enable/Disable viewing of nodes in the model 

 Extrude:  Enable/Disable viewing of extrude model 



39 
 
 

 Display loads:  shows loads applied to the structure depending on their type. To show a load type, click 

on the drop-down menu and choose between point, line, area or volume.  

 

Then select the wanted load case form the bottom toolbar. 

 

 

 

View controls:  Through this panel it is possible to change the parameters of the view. 

 

- Partition opening: experimental function that enables loading ADAPTIC partitions; 

- View Settings shows the point of view and other graphics options of the model; 

- Nodes number shows the number of the nodes in the model; 

- Nodes masses displays the positions of nodal masses in the model; 

- Element number shows the number of the elements in the model; 

- Values on diagrams shows values in the beams force diagrams; 

- Values on loads displays the values of applied loadings; 

- Constraints displays the applied constraints in the model; 

- Restraints displays the applied restraints in the model (active by default); 

- Hinges in beams displays the hinges applied to the beam elements (active by default); 
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- Display in decimal format shows all number in viewport (both for loads and results) in the desired 

format (e.g. “0.000”). 

In the box called Values on diagrams it is possible to specify which values have to be reported in the viewport when 

Values on results is activated. This allows to enable/disable values for each one of the 5 output stations in a beam 

diagram. 

 Model data:  This tool allows to see the Nodes, Elements or Loads in the model as long as theirs coordinates. 

 

From this mask it is also possible to modify loads and restraints simply by changing the values in the showed table 

and then clicking on Store changes. 

 

 Model tree:  Shows the main properties of the model (materials, sections and loads currently applied). 
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2.6. Draw menu 

Node:  Inserts nodes in the model, after a working plane is selected. 

Node by coordinates:  Inserts nodes by coordinates. To insert a nodes by coordinates, insert them on the 

textboxes and then click on the Add button. It is possible to insert nodes until the Close button is pressed. 

 

 Truss: Inserts truss elements between two nodes. This element can react only in tension or compression. 

 Beam: Inserts beam elements between two nodes. To insert a beam element select a section and a 

material from , if it has already been defined, from Selected section drop-down menu in the Section selection 

window and then click on the nodes to be connected. Once finished click on the Close button in the 

Selected nodes window. 

 

 Beam3: Inserts a 3 nodes beam elements. The three nodes must be aligned. 

Triangle: Creates a 3 nodes triangular plane element. 
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Triangle6: Creates a 6 nodes triangular plane element. 

 WARNING: Triangle6 elements are transformed in a group of 3 nodes elements with the default solver. 

Quad: Creates a four nodes quadrilateral plane element. 

 Quad8: Creates an eight nodes quadrilateral plane element. 

 WARNING: Triangle6 elements are transformed in a group of 3 nodes elements with the default solver. 

Tetra:  Creates a 4 nodes tetrahedron. 

Tetra10:  Creates a 10 nodes second-order tetrahedron. 

Wedge: Creates a 6 nodes wedge. 

Wedge15: Creates a 15 nodes wedge. 

Hexa:  Create an 8 nodes hexahedral element. 

Hexa16:  Create a 16 nodes hexahedral element. 

Hexa20:  Create a 20 nodes hexahedral element. 

 Spring:  Creates a 2 nodes spring. 

 WARNING: To create a spring element, the spring properties must be specified in Assign/Spring properties 

and then assigned to the element. 

 Grid manager: it manages all grids in the viewport, to support drawing nodes. In grids, at each line intersection, 

snap is available. 

 

Views control: it creates and handles model views. 
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2.7. Assign menu 

Loads 

Automatic loading:  Allows to assign to all the elements in the model some automatic-generated loads, such as 

self-weight and wind loads. 

The command Assign self-weight loads produces the distributed load only for the elements having a material and a 

section assigned to. 

The command Assign in the Wind loads box produces the assignation of wind load to all the Line elements in the 

model, in the chosen direction. The loading is calculated from a defined user function, and applied to the lateral 

surface of each element, obtained from the largest edge of the transversal section. 

 

Point load: Applies a concentrated loads to selected nodes. To insert a concentrate load: 

- Select one or more nodes; 

- Insert the loads value in the Load value box; 

- Select the direction clicking in a radio-button on the Direction box; 

- Select the load case on the Load case drop-down list; 

- Click on the Apply button to set the load. 

To use a value from a defined function, pick the desired function from the Pick function menu and then 

specify the value from which read the function the in the At X menu. Optionally, a multiplier for the 

resulting value can be specified. 
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Finally, the option Temperature allows to assign a nodal temperature to be used in Heat-transfer load cases. 

 

Distributed load:   To insert a distributed load on a line element: 

- Insert the value of the load in Uniform load value box specifying the correct sign in global coordinate 

system; 

- Select the Direction of the load; 

- Select the proper Load case; 

- Select the element in the model and click on the Apply button. 

To remove a distributed in the selected load case, select the element in the model and click on the Remove 

button. 

By the Non-uniform  loading box it is possible to insert linear distributed load by points, specifying the 

proper distance for the input values. 



45 
 
 

 

 WARNING: The units need to be consistent with the initial choices [Force/Length]. 

 WARNING: Since version 1.3, non-uniform loading is supported even in the default solver. An indefinite 

number of multi-linear distributed loads can be applied on the same beam. 

 WARNING: Rigid offsets applied on beams having non-uniform loads must be placed before and/or after the 

beginning or the end of the loads, otherwise they will not be considered. 

 WARNING: Line3 elements, for compatibility reasons, do not support non-uniform loading. Line elements 

can be used without losing accuracy. 

Temperature:  Applies a thermal load, which causes a structural deformation, to the selected beams and planar 

elements. Beam element support the uniform gradient and the linear temperature gradient, in both y and z 

directions of the transversal cross section. Planar elements support only uniform gradient. Finally, solid elements do 

not support thermal loading. 
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Edge load: Applies an uniform load on an edge of an element. It can be used to assign forces per unit of length 

(Force option) or temperatures (Temperature option). This last option is intended to be used of heat transfer analysis 

only. After you selected the planar element, from the Select side box it is possible to highlight the chosen edges. 
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Non-uniform loading box allows to set a final value for load. The button Apply on path by selected nodes allows to 

apply edge loads following selected nodes. 

Floor load: Applies a floor load on a triangular surface defined by Line elements or quadrangular by selecting 3 or 

4 nodes. Choose the floor type within: 

- Centroid-trilateral plane: to load a triangular plane distributing the load all over its sides; 

- Centroid-quadrilateral plane: to load a quadrilateral plane distributing the load all over its sides; 

- One-way quadrilateral plane: to load a quadrilateral plane on 2 or more sides taking into account the load 

direction (i.e. floor frames); 

- Two-way quadrilateral plane: to load quadrilateral plane with 2-way distribution (tributary area method). 

In the Set floor load mask target load cases and relatives values can be specified. 

In the Load direction box it is possibile to specify a direction for applied loads. The default setting Normal to plane 

applies the loading normal to the plane by considering its clockwise or counterclockwise orientation. This setting 

will be ignored if another direction is specified. 

To draw the plane once selected the desired plane load, select Draw plane. 

 WARNING: input loads in this section must have F/L2 dimension. 

 WARNING: edge plane elements can only be of Line type. 

 WARNING: the plane drawing direction defines the load sign (positive or negative) in the global coordinate 

system - draw planes counter clockwise to keep the value defined in the Set load table. 

The Tools menu  allows you to access these commands: 

− Transform to beam loads to transform floor loads into distributed loads per unit length on beam elements. 

In this way, the parameterization associated with the type of floor load is lost; 

− Duplicate selected  allows you to duplicate the drawn plane, with the purpose, for example, of reassigning it 

to another type of load without redrawing it; 

− Change type allows you to assign a different type to the existing load plan; 

− Invert changes the order of the nodes of the selected load plan. Useful for load types defined according to 

the normal to the plane. 
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Pressure load:  Applies a pressure load on planar elements. 

 

The Non-uniform loading box allows to apply a bilinear load on a face of planar element. 
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Volume load:  It applies a load per unit of volume on solid elements. 

 

Point displacement:  Applies displacements to selected nodes. 

 

Initial temperature:  Set the initial temperature in the model. 

 WARNING: This command affects only thermal analyses. It does not affect the loads induced by thermic 

distortion. 

Pretension load:  Applies pretension loads to linear (truss and beams) elements. A positive value signifies a 

tensioned element (i.e. tendons, cables). Only positive values are permitted (i.e. element in tension). 

 

 WARNING: The load is displayed as a uniform thermal distortion on the element. The value of distortion will 

have the opposite sign of the assigned pretension. 

Nodal loads from RS: apply nodal loads from an already run Response Spectrum analysis for the same model. 
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The command requires: 

− Source loadcase: set to the Response Spectrum case from which loads are read 

− Target loadcase: set to a new Linear Static loadcase to host the applied nodal forces 

− Mode: set the mode number to take the forces from. Leave it 0 to assume loads combined with CQC 

− Clean target loadcase: set to Yes to clean all the loads already present to the target loadcase. 

By pressing OK, the program applies the nodal loads: 

− If a rigid diaphragm is present, to the sole master node, by summing all the contributions from related 

nodes 

− If the floor is not rigid, to all nodes that have associated mass. 

Point Mass:  Applies masses to selected nodes. 

 

  WARNING: The units need to be consistent with the initial choices. 

 WARNING: You may want to add the nodal mass in all the three translational directions. 

Masses from loads: Allows to transform, automatically or once at a time, the loads contained in a load case into 

masses. Checks in 'Set masses in' activate or deactivate the mass in the corresponding direction. 
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The "Assign nodal masses from loadcase" box is used for assigning masses in the directions specified above without 

changing them as loads change. 

Local axes rotation: In the Beams box, the command rotates the selected beam sections by the counter-

clockwise angle specified. 

In the Planar Elements box, it rotates the planar local axes by changing the element connectivity. 

The Reverse connectivity command is used to reverse the Z axes of plane elements. 

 NOTICE: With non-regular meshes (e.g., triangular), all local axes should be rectified in order to read the 

results in terms of stresses and strains consistently 

 

Restraints: Assigns restraint to the degrees of freedom selected by checking the appropriate check box. 

 

 In viewport, the following drawing conventions applies: 

­  x, y and z checked (simple support) 

 

­ all checked (fixed end) 
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­ x, y, z and ry, rz blocked (fixed in XZ plane, simply supported in YZ plane) 

 

­  y and  z fixed, slider in plane xz 

 

­  x, y, z and rx blocked 

 

­ only ry blocked 

 

­ rx and ry blocked 

­ all other restraint types. 

 

Constraints:  Assign a constraint (i.e. rigid diaphragm or master-slave link) to selected nodes. By the 

Rigid diaphragm preset, a rigid floor can be applied to the selected nodes. 

 

  WARNING: The master node must be bounded properly to avoid singularities in the model. This 

procedure always proposes the proper boundary conditions automatically. 

 

End releases: Assigns end releases to beam elements. By specifying a value between 0 (fully released) and 1 (fully 

fixed) in the textbox next to the check, a partial end release to be used in a linear elastic analysis can be obtained. 
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The reduction factor r is applied to reduce the stiffness of the beam by the ratio r/(1-r). 

The option “ Input stiffnesses” allows to directly set stiffness values instead of force ratios. 

 

Rigid offset: Assigns one or more rigid offsets to beam elements. 

 

  WARNING: Loads on a beam with rigid offsets are not modified not changed or adapted to the rigid 

segments. As a result, distributed loads on beams can decrease in their overall intensity due to the lesser length of 

application. 

Element properties: Assigns custom properties to beam elements. For the property names and reserved values 

see chapter 4. 

In addition, from this mask it’s possible to assign a beam section offset at element level, 

from the box Beam section offset. 
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Hinges: Assigns plastic hinges to beam elements. After the name of the hinge has been inserted, press Add. At 

this point, each DoF of the hinge can be set by inserting the properties listed below. Press Modify to 

save the hinge properties. 

The Hinges options box allows to specify under which loading conditions all hinges have to be 

recalculated. This is particularly useful for hinges with NVM interaction. 

 

Data requested for a Bilinear Symmetric plastic hinge are: 

- Fy: strength at elastic limit; 

- cKpl: coefficient to set the slope of the plastic branch Kpl=cKpl * Kel; 

- : hinge ductility; 

- Fres/Fy: residual strength in percentage of Fy. 
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Data requested for a Bilinear Unsymmetrical plastic hinge are: 

- Fy+: strength at elastic limit; 

- cKpl+: coefficient to set the slope of the plastic branch Kpl=cKpl * Kel; 

- +: hinge ductility; 

- Fres/Fy+: residual strength in percentage of Fy+ 

- All the above quantities followed by a “-” sign: to define the negative part of the hinge law. 

 

The hinges inserted with Custom properties are defined by setting all the above data. 

By selecting NVM from the DoF dropdown menu it is possible to assign an axial/shear/flexure interacting hinge. The 

calculation of all its properties is made automatically on the assignation on the base of checking type selected from 

the dropdown menu Hinge type. NVM hinges always have an unsymmetrical bilinear law.  

 

Hinge status can be seen together with beam diagrams results, with the following convention. 
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Member: Assigns one or more elements to a member. This affects the verification of a beam element. 

 

Rebars: Assigns reinforced bars to beam elements. By selecting the desired section from the Beam sections 

box, the potential rebar defined in Assign/Sections/Strength is shown and it can be applied to the beams having that 

section. 

The table in the box named Assigned rebar shows the longitudinal and shear reinforcements assigned to each beam, 

or to a portion of a beam by specifying the Start at and Ends at values. 

The Rebar position box allows to define and change longitudinal and shear reinforcements. Stirrups are defined in 

the Shear reinforcement sub-box. The Fast rebar positioning box allows to easily insert simple rebar schemes for the 

most common sections. 

Span drawing shows the longitudinal section of the beam, highlighting the selected part. 

 WARNING: units of measure used in this mask are the same defined for the model, except for the diameters of 

the available bars in the dropdown menus, with are shown in mm. 
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The Plot pop-up menu contains several commands: 

 

 

− [Load Case Selection Drop-Down] 

− Mzz draws the graph of the stress Mzz and the corresponding resistance moment to the same abscissa; 

− Myy draws the graph of the stress Myy and the corresponding resistance moment to the same abscissa; 

− Vy draws the graph of the stress Vy and the corresponding resisting moment at the same abscissa; 

− Vz draws the graph of the stress Vz and the corresponding resisting moment at the same abscissa; 
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− Use elastic limit activates the resistant calculation according to using the materials in the elastic field; 

− Show Members:  Enables the grouping of the members defined as a single element in this form; 

− Split Reinforcing Segments divides the selected reinforcing segment into the number of segments specified 

by the user. Useful, for example, to increase the definition of bar positions in variable section beams; 

− Rebar angle for wall allows you to assign an angle for arranging rebar in wall elements or groups. Useful for 

example for defining the main reinforcement directions in slabs. 

Spring properties: Add, modify or assign one set of properties (elastic stiffnesses) for linear springs.  

It is also possible to specify and assign subsoil distributed springs on beam elements (as elastic foundations) by 

using the box Elastic soil properties in Z direction by using the button Add soil spring after having set the Winkler’s 

modulus and the Beam width. 

 

The button Add nodal springs contains the following commands: 

 

- The Assign as nodal spring to selected nodes button allows to assign to a node the selected spring, 

connected to another fully fixed node that is automatically restrained, 

- The Assign springs to selected overlapped nodes command allows to easily assign zero-length springs to the 

selected overlapped nodes, 

- Assign soil springs to nodes of selected elements permits to assign springs (typically of type “Subsoil”) to the 

nodes of selected elements, 

- Remove all nodal springs of selected type removes all the springs of the selected type in the model, 

- Add spring of selected type to node in element adds a spring of the selected type between a selected node of 

the currently selected element. The command then asks you to select a single element and a single node 

belonging to that element, and duplicates the selected node by adding a spring. 

It is possible to assign non-linear properties for a translational (x, y, z) or rotational (rx, ry, rz) DoFs, either in global or 

local coordinates as specified in the upper right corner of the property box. By clicking on the NL checkbox, the non-

linear properties dropdown will list all the hysteretic laws available. Select one item from the dropdown to set 

properties. 
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 WARNING: in order to define the non-linear properties, it is necessary to add a spring property first. Once the 

non-linear properties have been defined, click on Modify property to store them. 

The non-linear models available in NextFEM Designer are: 

- Gap: gap spring is particularly useful for representing contact (i.e. gap with null opening). Such model 

works only in compression with the stiffness defined by the user. 

Data requested for Gap are: 

▪ closure: maximum closure of the gap; 

▪ Kclosure: slope of the compression branch. 

 

 
 

  

- Hook: this law reacts only in tension. Data requested for Hook are: 

▪ opening: displacement at which tension stiffness is not null; 

▪ Kopening: slope of the tension branch. 

 

 

 

 

- Bilinear Plastic: the elastic behaviour is maintained until the yielding force Fy is reached, then the plastic 

field begins. Once the ultimate displacement Uu is achieved, the spring breaks, maintaining a residual force 

Fres. This law has a symmetrical behaviour. 
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Data requested for a Bilinear Plastic behaviour are: 

▪ Kel: elastic stiffness assigned to the spring; 

▪ Fy: strength at elastic limit; 

▪ cKpl: coefficient to set the slope of the plastic branch Kpl=cKpl * Kel; 

▪ Uu: ultimate displacement; 

▪ Fres: residual strength after collapse. 

 

- Bilinear Unsymmetrical: this behaviour is suitable for modelling non-symmetric behaviour in structural 

elements. This law has an unsymmetrical behaviour. 

 

 

 

 

Data requested for a Bilinear Unsymmetrical type behaviour are: 

▪ Kel+: elastic stiffness assigned to the spring; 

▪ Fy+: strength at elastic limit; 

▪ cKpl+: slope of the positive plastic branch; 

▪ Uu+: ultimate displacement allowed; 

▪ Fres+: residual force for 
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▪ All the above quantities followed by “-“ are the same properties for the compression side. 

 

- Trilinear Plastic: after reaching the plastic field, the skeleton curve is characterized by an hardening branch 

bringing to Fmax, followed by a hardening/softening one that leads to failure at Uu. This law may have or 

not a symmetrical behaviour. 

 
 

Data requested for a Trilinear Plastic behaviour are: 

▪ Kel+: elastic stiffness assigned to the spring; 

▪ Fy+: strength at elastic limit; 

▪ Kp1+: slope of the first plastic branch; 

▪ Fmax: maximum strength reachable; 

▪ Kp2+: slope of the second plastic branch; 

▪ Uu+: ultimate displacement in positive direction; 

▪ All the above quantities (except Fmax) followed by “-“ are the ones for the compression side; 

▪ Fmin: maximum strength reachable in compression. 

- Pivot rule: such model follows the rules defined in Dowell RK, Frieder S, Wilson LE. Pivot hysteresis model for 

reinforced concrete members. Struct J 1998;95(5):607–17. The law can be set as not symmetrical. The 

definitions of the pivot points can be made by setting the  and  parameters. 

Referring to the Trilinear Plastic rule, the additional parameters are: 

▪ alpha1: sets the pivot point for unloading from a tensile force to zero; 

▪ beta1: sets the pivot point for reverse loading from zero to a negative force. Must be set between 0 

and 1; 

▪ alpha2: sets the pivot point for unloading from a compressive force to zero; 

▪ beta2: sets the pivot point for reverse loading from zero to a positive force. Must be set between 0 

and 1. 
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- Tomazevic-Lutman model: represents a trilinear behaviour as defined in Tomazevic M, Lutman M. Seismic 

behavior of masonry walls – modeling of hysteretic rules. J Struct Eng 1996:1048–54. It is influenced by 

parameters alpha and beta, which determine the stiffness and the strength degradations, respectively. This 

model is suitable for shear DoFs in masonry walls. This law has a symmetrical behaviour. 

 

 

 

 

Data requested for Tomazevic-Lutman model are: 

▪ Kel: elastic stiffness assigned to the spring; 

▪ Fy: strength at elastic (cracking) limit; 

▪ Kpl1: slope of the first plastic branch; 

▪ Fmax: maximum strength reachable; 

▪ Kpl2: slope of the second hardening/softening plastic branch; 

▪ cF: coefficient to set unloading force ratio from the backbone; 

▪ alpha: coefficient for linear stiffness degradation at unloading (Kult=alpha*Kel); 

▪ beta: coefficient for strength degradation on the base of energy dissipated in a cycle (default 0.06); 

▪ Uu: ultimate displacement. 

 

- Ring-shape: this model represent a poor dissipative cyclic behaviour and can be used, for example, for 

flexural DoFs in slender masonry panels. The backbone can be bilinear if Kpl2 is set to zero. 
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This law has a symmetrical behaviour. 

 

 

 

 

Data requested for the Ring-shape model are: 

▪ Kel: elastic stiffness assigned to the spring; 

▪ Fy: strength at elastic (cracking) limit; 

▪ Kpl1: slope of the first plastic branch; 

▪ Fmax: maximum strength reachable; 

▪ cC: coefficient to set the slope of the unloading path; 

▪ cF: coefficient to set unloading force ratio from the backbone; 

▪ alpha: coefficient for linear stiffness degradation at unloading (Kult=alpha*Kel); 

▪ cD: way point for the unloading path - distance from elastic limit in backbone curve; 

▪ Uu: ultimate displacement; 

▪ Kpl2: slope of the seconnd plastic branch, can be set to 0 to remove it. 

 

 

- Slip type: trilinear behaviour exploitable for shear connection in timber structures (nails, screws, angle 

brackets, ect.). Such law is based on the work Rinaldin G., Fragiacomo M. A Component Model for Cyclic 

Behaviour of Wooden Structures. Materials and joints in Timber structures: recent developments of technology, 

RILEM Bookseries, Vol. 9, pp. 519-530, 2014, DOI: 10.1007/978-94-007-7811-5_48, ISBN: 978-94-007-7811-5. 

This law has a symmetrical behaviour. 
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Data requested for the Slip-type model are: 

▪ Kel: elastic stiffness assigned to the spring; 

▪ Fy: strength at elastic limit; 

▪ Kpl1: slope of the positive plastic branch, must be ≠0 ; 

▪ Fmax: maximum strength reachable; 

▪ Kpl2: slope of the negative plastic branch, must be ≠0 ; 

▪ cKunload: it sets the unloading stiffness of the first branch of unloading (green) and of reloading 

(blue) path by multiplying the elastic stiffness by this factor; 

▪ cFreload: it sets the lower limit of last branch of reloading (blue) and unloading (green) path, in 

percentage of the force value in the backbone. Such parameter must be set between 0 and 1; 

▪ cFunload: it sets the lower limit of first branch of unloading (green) and reloading (blue) path, in 

percentage of the force value in the backbone. Such parameter must be set between 0 and 1; 

▪ Uu: ultimate displacement; 

▪ alpha: exponential strength degradation parameter based on dissipated energy; 

▪ beta: exponential strength degradation parameter based on maximum displacement reached; 

▪ gamma: linear strength degradation parameter; 

▪ cKreload: sets the unloading stiffness of last branch of the reloading (blue) and unloading (green) 

path by multiplying the elastic stiffness by this factor. 

 

- Unsymmetrical Slip-type: this behaviour is suitable for modelling hold-down connections in timber 

structures. Such law is based on the work Rinaldin G., Fragiacomo M. A Component Model for Cyclic Behaviour 

of Wooden Structures. Materials and joints in Timber structures: recent developments of technology, RILEM 

Bookseries, Vol. 9, pp. 519-530, 2014, DOI: 10.1007/978-94-007-7811-5_48, ISBN: 978-94-007-7811-5. 

This law has an unsymmetrical behaviour. 

 

 
  

 

Data requested for an Unsymmetrical Slip-type behaviour are: 

▪ Kel: elastic stiffness assigned to the spring; 

▪ Fy: strength at elastic limit; 

▪ Kpl1: slope of the positive plastic branch, must be ≠0 ; 

▪ Fmax: maximum strength reachable; 
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▪ Kpl2: slope of the negative plastic branch, must be ≠0 ; 

▪ cKunload: it sets the unloading stiffness of the first branch of unloading (green) and of reloading 

(blue) path by multiplying the elastic stiffness by this factor; 

▪ cFreload: it sets the lower limit of last branch of reloading (blue) and unloading (green) path, in 

percentage of the force value in the backbone. Such parameter must be set between 0 and 1; 

▪ cFunload: it sets the lower limit of first branch of unloading (green) and reloading (blue) path, in 

percentage of the force value in the backbone. Such parameter must be set between 0 and 1; 

▪ Uu: ultimate displacement allowed; 

▪ Fmin: maximum strength reachable in compression; 

▪ Kneg: stiffness coefficient for compression branch, multiplies the elastic stiffness; 

▪ cFend: coefficient for setting the force value at the end of the last branch of the unloading path 

(green), multiplies the yielding force; 

▪ cFinit: coefficient for setting the force value at the beginning of the first branch of the reloading 

path (blue), multiplies the yielding force; 

▪ alpha: exponential strength degradation parameter based on dissipated energy; 

▪ beta: exponential strength degradation parameter based on maximum displacement reached; 

▪ gamma: linear strength degradation parameter; 

▪ cKreload: sets the unloading stiffness of last branch of the reloading (blue) and unloading (green) 

path by multiplying the elastic stiffness by this factor. 

 

- Dashpot: represents a non-linear damper element accordingly to Kelvin’s model. This law is suitable for 

dynamic analysis, and gives a response defined as: 

0F C u K u F=  +  +   

where the stiffness is 
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The needed parameters are: 

▪ Kr: restoring stiffness of the dashpot; 

▪ C: damping coefficient; 

▪  damping exponent; 

▪ K0: initial stiffness of the dashpot; 

▪ F0: preloading force. Below this value, damper is not active. 
 

- AMD: represents a linear damper (except for Fmax, Vmax, and Dmax limits) as per Maxwell model (damper 

and spring in series). If Fmax is non-zero, the damper limits the supplied force by behaving elastically-

perfectly plastic. Vmax and Dmax can be used to represent an Active Mass Damper with limits in velocity 

and displacement. Required parameters are: 

▪ K: damper stiffness 

▪ G: damping coefficient 

▪  damping exponent; 

▪ Fmax: maximum force for the damper 

▪ Dmax: maximum displacement of moving mass 

▪ Vmax: maximum velocity of moving mass 

State variables are available for this element, which can be consulted in Extract data mask, under 

'Stations/Points'. They contain, in order: 

▪ s1: speed at i-th step 

▪ s2: force at pitch 

▪ s3: energy dissipated by the damper 
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▪ s4: acceleration rel. mass 

▪ s5: mass-related velocity 

▪ s6: displacement rel. mass. 

 

 

 

- VRM: simulates a broad class of complex hysteresis loops as described in Vaiana N, Rosati L (2023) 

Classification and unified phenomenological modeling of complex uniaxial rate-independent hysteretic 

responses. Mech Syst Sig Process 182: 109539 and in Vaiana N, Rosati L (2023) Analytical and differential 

reformulations of the Vaiana-Rosati model for complex rate-independent mechanical hysteresis phenomena. 

Mech Syst Sig Process 199: 110448. 

 

The data required by the Vaiana Rosati model are: 

• kb+: angular coefficient of the upper boundary line cu (Fig. a) 

• f0+: ordinate of the point P+ (Fig. a) 

• alpha+: parameter that adjusts the curvature of the load curve f+ (Fig. a) 

• beta1+: parameter that transforms cu into a curve without an inflection point by adjusting its 

curvature (Fig. b) 

• beta2+: parameter that transforms cu into a curve without an inflection point by adjusting its 

curvature (Fig. b) 
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• gamma1+: parameter that transforms cuinto a curve with inflection point P+ by adjusting the 

distance between a+ and b+ (Fig. c) 

• gamma2+: parameter that transforms cuinto a curve with inflection point P+ by adjusting the 

slope of c+ (Fig. c) 

• gamma3+: abscissa of the inflection point P+ (Fig. c) 

• umax: positive ultimate displacement 

• All previous parameters followed by "-": the same properties for the unloading phase 

• umin: negative ultimate displacement. 

 

 WARNING: for the use in OpenSees of non-linear springs, see www.nextfem.it/it/opensees/ to install the 

OpenSees solver. Also set the desired options in the boxes in the Options mask, tab Misc. 

 

Generate combinations 

This command allows to the safety factors and the partial coefficients for the automatic generation of load 

combinations as per Eurocode. 

The Self-weight override option permits to apply a different coefficient to self-weight loadcase, as requested by some 

codes (e.g. Italian regulations). 

 

http://www.nextfem.it/it/opensees/
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It is possible to generate fundamental (ULS resistance), service (SLS) or seismic combinations, including the 

direction combination of 2 or 3 seismic cases specified in the Seismic Directional Combinations box. It is possible to 

prefix the name of the combination, which is particularly useful when writing seismic combinations referring to 

different spectra (e.g. LLS and DLS). 

The option Consider 5% eccentricity enables the assignment of equivalent torques to the plane forces in the 

dedicated cases named *exc5x and *exc5y, which are automatically generated and combined. For an analysis with a 

response spectrum in the X and Y directions and with active eccentricities, 32 combinations are thus generated 

instead of the 8 without the option. 

The calculated combinations can be edited from the Analysis settings command. 

 

Analysis settings: Defines the type and the sequence of the analyses. The combinations can be defined 

adding linear load cases to a defined case. To add an analysis, select an Analysis mode, an Analysis type and, if 

needed, a Combination type. Then click on Add. 

 

 

The program allows the following types of linear and non-linear analysis: 

- Static 

- Dynamic 

- Response spectrum analysis (user must check Dynamic first, and the option Response spectrum. Hence, a 

design spectrum can be selected from the TH load or spectrum box) 

- Modal, to find structural periods and eigen-vectors of a model; 

- Buckle, to find the buckling modes of a model; 

- Heat transfer, to analyse models in XY plane and to get thermal maps (for example from a section); 
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- P-Delta, for static analysis including second-order geometrical effects. Such kind of analysis are carried-out 

iteratively, but in only one loading step, and results can be used in combinations. To include second order 

geometrical effects in multi-steps non-linear analyses, flag the option named “2 nd order”. 

In the Combination mode box, user can choose the type of combination to be performed: 

- Base for all the linear static load cases 

- Sum for the load combinations in which the cases specified in the Linear loadcases box must be summed; 

- Envelope for the load combinations in which the cases (or combinations) specified in the Linear loadcases 

box must be enveloped; 

- SRSS to perform a Square Root of the Sum of Squares of the cases (or combinations) specified in the Linear 

loadcases box. 

From the Type drop-down menu in the Analysis sequence and combination box, the type of each loadcase or 

combination can be chosen, for using in checking. If this has not been specified, checking could not be run for the 

specific combination. 

With the command Export combos in CSV file, a CSV file containing all the combinations and their combination 

coefficient can be obtained in a tabular format. 

For dynamic analyses, damping can be specified in terms of Rayleigh’s coefficients, while for the Response 

Spectrum analysis damping ratio of the spectrum employed is required. 

Finally, for applying a displacement history (as defined by imposing displacement) in non-linear analyses, set Factor 

to 0. 

The Other tools pop-up menu contains these commands: 

− from Export Combination Table it is possible to obtain a CSV or Excel file containing the combinations 

entered and the relative combination coefficients adopted; 

− Recalculate Results in Combos allows you to force the recalculation of combinations with the current results; 

− Assign duration to load cases allows you to associate a duration class to each load case or combination, for 

use in checks for wooden structures; 

− Buckling Load Case Type allows you to specify whether the load cases contained in the current buckling 

analysis are to be considered as constants or variables in the determination of the multiplier. 

2.8. Tools menu 

 Run: This option allows to run all the analyses. 

 Run selected: This option allows to run the selected analyses. To exit without running anything, set all to No and 

press OK. 
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Login to cloud: This option allows to run analyses on the NextFEM cloud by connecting to the NextFEM 

server using the user’s credential. To log into the cloud insert your Username and your Password obtained 

from the registration on the NextFEM Internet site. 

 

Once connected to the cloud it is possible to launch analyses by selecting them from the Select case to run 

list and then click on the Submit button. 

 

Once the analysis has been submitted, it will be completed in the cloud. When the analysis is completed it 

is possible to view the result at any time clicking on the Retrieve results button. 

 

 Query:  Provides information about the selected element/node. By picking 2 nodes, it is possible to 

measure the distance between them. 
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 Screenshot:  Copies to the clipboard the current viewport 

Model wizard:  it allows the guided setting of a new model through the definition of materials, sections, load cases 

and masses. 

Frame generator:  This command generates automatically a regular spatial frame. The input data are: 

- The number of bays along X and Y, the number of story and their span;  

- The material and the transversal section to be assigned to the beams and columns 

- OPTIONAL: the loads to be assigned to beams by choosing the roof framework direction. Target load cases 

must already be defined to proceed; 

- OPTIONAL: you can apply automatic floor diaphragms. 
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Section from model:  It allows a section to be created from a model in which the thermal analysis has been 

carried out in the XY plane. The command then asks for certain parameters for choosing the functions for 

fire testing (fire curve, material degradation curves, etc.). 

 Add plinth: Adds a shell-modelled plinth on elastic soil to the selected node. The restraints of the node are 

overwritten with a constraint compatible with the elastic soil (X, Y and RZ). The command asks as input the 

plan dimensions of the plinth, the plinth thickness and material, and the elastic soil type which must 

already be defined. 

Options:  It allows to change the visualization options as long as the solver options.  

To change from the default solver (OOFEM) to OpenSees the user must enter the Path to OpenSees.exe box.; 

to use the solver CalculiX the user must enter the Path to ccx.exe.  
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 WARNING: OpenSees and CalculiX solvers are not fully supported, not distributed by NextFEM and not 

shipped with the program. 

The option Save results in NXF files allows to save the results of a model in the NXF file, only if the 

calculations are performed with OOFEM. 

The option Autosave model every n minutes allows to automatically save the model every n minutes as 

specified by the user. 

The option Include curvature and strain in shell results allows to get curvatures and strains in results for shell 

elements. Enabling this option may slow down the analysis and increase the model weight. 

The option Solver allows the user to choose the default solver: 

- Standard: it’s the standard solver which allows to detect labilities in the model;  

- DSS solver: Direct Sparse Solver, optimized for fast solving of large problems. Labilities will not be 

detected; 

- SPOOLES solver: SParse Object Oriented Linear Equations Solver, optimized for fast solving of large 

problems. Labilities will not be detected. 

Path for temporary files shows the temporary folder used by the solver. 

OOFEM Preferences 

The option Include shear deformation in beam elements activates the Timoshenko contributions for beams in 

the default solver. 

The option Reduced integration for 4-node shells activates the reduced integration for 4-node quad elements 

in the default solver. 

Import Preferences 

The option Read nodal velocities and accelerations from NUM files enables the reading of velocities and 

accelerations in results import from ZeusNL files. 

BIM Preferences 

The option Size for IfcWall mesh allows to specify the mesh size to be used during import of IfcWall elements 

from IFC or IFCxml files. 

General preferences 

It allows to set the tolerance for merging nodes and to set the separator for CSV export. 

2.9.  Plugins 

This menu section lists all the plugins loaded at startup. Plugins are in English language only, and they are 

completely independent from Designer. For further information: www.nextfem.it/dev/ 

Some plugins are included by default in NextFEM Designer, such as: 

Floor modeller, to transform a loading plane to a shell plane loaded on surface; 

Custom report compiler, to compile a DocX document by including data and images from model; 

Parametric solver to carry-out parametric analyses in an easy way. 

2.10. Results menu 

 Display results:  It shows the result of the analysis by load. To show the appropriate Result type, LoadCase; 

DataSet and Component,  select them from the respective drop-down lists. 

http://www.nextfem.it/dev/
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Available results can vary on the base of the performed analysis, and can be: 

- Frame forces to show beam diagrams 

- Frame Displacements to show a contour of beam deflections 

- Frame subsoil reactions to show a contour of the soil reactions for beams with subsoil springs 

- Node Displacements to show the deformed shape and a contour of nodal displacements 

- Node Velocities to show the deformed shape and a contour of nodal velocities 

- Node Accelerations to show the deformed shape and a contour of nodal accelerations 

- Node Reactions to show the nodal reactions in restrained nodes as arrows 

- Area Forces to show forces per unit of length in planar elements 

- Area Stresses to show stresses in planar elements 

- Area Strains to show deformations in planar elements 

- Solid Forces to show solid elements forces 

- Solid Stresses to show solid elements stresses 

- Solid Strains to show solid elements deformations 

- Node data to show node-related data such as checking ratios or custom values 

- Element data to show element-related data such as checking ratios or custom values 

- Area temperature to show the thermal map of planar elements 

- Solid temperature to show the thermal map of solid elements (not yet available). 

 

 Animation:  Shows animation of deformed shapes through time or exports a video on the selected result. 

Extract data: Extracts results data in tabular format. 

 To extract the result follow the following procedure: 

- Select a load/step by clicking on it in the Select load case or step list; 

- Select a time or mode by clicking on it in the Select time or mode list; 

- Select a data type, so that a result type from the Select data type list; 

- Select the number of the node or element in the Number list. 

- Optionally, choose the number of stations/points in the Stations/points window. 

To export the shown data in a tabular format, press Export as CSV button. The command Export all as CSV allows to 

export all the data of the selected type (in the Select data type box) for all elements or nodes. 

The Operation on values box allows to apply simple orations (sum, sum of absolute values, absolute values) on the 

requested (multiple) data. 

The Filter by box allows to display only data associated to selected materials, sections, etc. 
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 Model report:  Produces a model report in PDF, RTF or DocX formats. Tick the proper items to export them. 

 

Calculation report: Compiles the report of the model with the NextFEM general report template shipped with the 

program. The following command Custom template allows the user to supply a Word template to be compiled. The 

template must contain the keyword as defined in the plugin Custom report compiler. 
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Set contour limits:  It allows to set the limits in the current displayed contour plot. This mask contains also 

commands to plot the isocurve of a certain values for some selected shell results (stresses, forces, 

temperature).  

 

 WARNING: The contour limits affect the colours associated to the extreme values of contour. Any value 

exceeding the limits will be associated with the colour of the nearest extreme limit (red or blue). 

Delete saved results: Allows the deletion of the saved results in the NXF file. 

 

Delete saved checks: Allows the deletion of the saved checks in the NXF file. 
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Sum of loads and masses: produces a report on the sum of reactions in Z direction for each base loadcase, 

reporting also the summation of the masses present in the model. 

 WARNING: for wind loadcases, the returned value is the highest sum amongst the X, Y and Z directions, 

calculated on reactions. For all the other cases, applied loads are summed. 

Bill of materials: produces a report on the sum of volume and weight for each material in the model, ordered also 

by sections. 

Storey stiffness: calculates the floor stiffnesses obtainable from two user load cases containing horizontal forces 

for each floor. These cases can be obtained when writing seismic combinations or from the Functions mask. 

More output stations: allows continuous diagrams to be displayed by increasing the number of stations 

employed. 

 WARNING: Additional stations are not saved in the file. The command resets when saving the model or 

opening. 

 

 Verifications:  It allows to handle and checks some defined quantities on nodes/elements. 

To check nodes/elements, the following procedure has to be done: 

- choose a quantity to check from the quantities drop-down list; 

- Choose a load case and a time/mode (or select ALL for all times/modes); 

- Import the formulas from a customized *.txt file (see chapter 4); 

- Click on the Perform checks button. 

The results are shown on the output area in tabular and textual format, if required with the “ Save log for each 

station” check. They can be exported in text format by clicking on the Export table…  button. 

Finally, the areas 'Verification Settings', 'Textual Results on Selected Object' and 'Launch Verification' can be hidden 

by pressing the grip button on the respective border. 

 

Please refer to the dedicated chapter for a full reference of the Verification tool. 

Smart checking: allows to automatically select the proper verification on the base of the element material. In 

addition, displays checking results filtered by transversal section. 
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 WARNING: the selected codes for checking for each material are the same associated to the keys combinations 

CTRL+1 – 7. 

Fire checking: the command starts the first phase of the fire checks for the frame structures on the selected beam 

elements. 

In the window that appears you can select: 

- Analysis and design curves: select Eurocode 2 for structures in reinforced concrete, Eurocode 3 for steel, Eurocode 9 

for aluminium; 

- Load combination: select the exceptional load combination to use for quick verification; 

- Section selection criterion: the section used for verification must meet the selected criterion (maximum moment My, 

maximum moment Mz, maximum in both directions Myz) 

- Sides exposed to fire for beams: the sides considered as exposed for the thermal analysis for the horizontal or sub-

horizontal elements; 

- Sides exposed to fire for columns: the sides considered as exposed for the thermal analysis for vertical elements; 

- Final fire analysis time in minutes: select the analysis time for which the resistant check of the section will be 

conducted. 

The Run all analyses option allows you to launch the files created in the same folder as the current model, saving the 

results for each. The Show Results option displays the 500°C isotherm for each thermal analysis in a separate 

window. 



79 
 
 

 
The command returns a table containing the demand / capacity ratios of the analysed sections in the Check-NMM 

(pressure and bending) and Check-V (shear) columns. The images relating to the resistant verification are saved in 

the same folder as the model (representation of the section and neutral axis, reduced resistant domain due to the 

effect of fire). 

 

IDEA CheckBot: this command executes IDEA StatiCa® Code Check Manager on selected nodes and/or elements. 

 WARNING: in order to work properly, the option “StatiCa installation folder” under Options must be 

correctly set. 

 Overturning check: executes the overturning check on the whole model, assuming it as a rigid body. This 

command calculates the overturning and stabilizing contributions for each load present in the model (except for 

thermal loads and distortions) and produces their summation. 

The check is conducted with respect to rotation axes in XY plane, passing through the nodes bounded in Z 

direction. The program can select automatically the 4 peripheral nodes or the user can specify such nodes. It is 

possible to specify a rotation angle, defined in XY plane, for the rotation axis (default 0° = X global axis). 

The checking is carried out automatically for the specified axis and its normal axis, producing a table with each load 

case, containing base cases and combinations of type linear add, showing the overturning moment. If this is 

negative, the configuration is stable. Otherwise, the structure is not. 

 WARNING: the overturning check is performed with respect to the only loads applied as forces, 

concentrated of uniformly distributed. Applied moments and reactions are always neglected. 

 WARNING: linear distributed loads are not supported. The loading resultant is always assumed in the 

middle of the loading span. 

 WARNING: the automatic algorithm for the seeking of nodes looks for all the nodes restrained in Z 

direction and assumes their maximum obstruction. Always check the position of the nodes restrained in Z 

direction; if you’re in doubt please proceed by manua lly selecting the reference nodes. 

 Seismic capsizing of masonry walls: performs verification of the tilting kinematics of user-selected Wall or 

MasonryWall elements. The tilt direction is provided by the Z axis of the elements - to change it use the Assign / 

Rotate Local Axes / Reverse Connectivity command. Refer to the Wall element tutorial for more information. The 

command requires a license for the MasonryCheck module. They are calculated: 

Participation factor 
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𝑒𝑝 =
𝑊 · 𝑑1 + 𝑃 · 𝑑2

(𝑊 + 𝑃) · (𝑊 · 𝑑1
2 + 𝑃 · 𝑑2

2)
 

 Mobilization acceleration 

𝑎 =
𝑎𝑔 · 𝑔 · 𝑆

𝑞
 

 Collapse multiplier 

𝛼0 =
𝑀𝑠

𝑀𝑟

 

 Mechanism-activation acceleration 

𝑎𝑐 =
𝛼0 · 𝑔

𝑒𝑝 · 𝐹𝐶
 

With W own weight and d1 distance from hinge, P permanent and d2 distance from hinge, FC Confidence Factor, 
Ms stabilizing moment and Mr overturning moment. 
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2.11. Help menu (?) 

Help:   Opens the manual 

Check for updates:  Checks if the program is updated. The sub-command Check for minor updates…  allows to 

select further updates with minor changes and corrections. 

Language:   You can choose the interface to be in English or Italian. You must restart the program for 

the changes to take effect. 

License:    Manage license requests. 

 

About:   Credits and licenses. 
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3. Import/export features 

NextFEM Designer imports/exports to and from more than 20 proprietary and non-proprietary formats. 

The complete features are described in the manual dedicated to the ImportExport module. 

 

 

  



83 
 
 

 

4. Customization 

4.1. Expand material library 

The material library can be expanded by writing a CSV file (i.e. a text file using the semicolon separator), as in the 

following examples.  

- Steel 

Name;Code;E [MPa];G [MPa];n_;fyk [MPa];ftk [MPa];Wd [kN/m^3];Md [ton/m^3];CheckType 
S235;UNI EN 10025-2;210000;80769;0.3;235;360;78.6;0.801;1 
S275;UNI EN 10025-2;210000;80769;0.3;275;430;78.6;0.801;1 

- Concrete 

Name;Code;E [MPa];G [MPa];n_;fck [MPa];Wd [kN/m^3];Md [ton/m^3];CheckType 
C8/10;NTC2008;25331;10555;0.2;8;25;254.841998 
C12/15;NTC2008;27085;11285;0.2;12;25;254.841998 

The column CheckType specifies the verifications associated with the material. Insert: 

­ 1 for Steel 

­ 2 for Aluminium/Alloy 

­ 3 for Concrete 

­ 4 for Timber 

­ 0 for other materials. 

For other types of materials, all the columns are mandatory, except for “Md” – mass density, which will be calculated 

by the program in consistent units from Wd – weight density.  

Natively supported fields are: 

- E: Young modulus 

- n_: Poisson ratio 

- G: shear modulus 

- fk: characteristic strength 

- Wd: weight density 

- a_T: thermal coefficient for linear deformation 

- K: heat conductivity 

- Cp: specific heat capacity 

The property name can be followed by square brackets containing the unit of measure (eg. “E [MPa]”).  

The file must be placed in the “data” folder and its  extension must be *.nfm. 

4.2. Expand section Library 

The section library can be expanded by writing a CSV file (i.e. a text file using the semicolon separator) as follows:  

Name;Code;h [mm];b [mm];tw [mm];tf [mm];r [mm];A [cm^2];Jy [cm4];Wey [cm^3];Wpy [cm^3];iy [cm];Avz [cm^2];Jz [cm^4];Wez [cm^3];Wpz [cm^3];iz [cm] 
IPE A 80;UNI;78;46;3.3;4.2;5;6.375401837;64.37774091;16.50711305;18.97743881;3.177708713;3.070001837;6.852668856;2.979421242;4.692462888;1.036754887 

… 

The first four columns are mandatory.  
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Natively supported fields are: 

- h: height 

- b: base 

- d: diameter 

- t: thickness (for pipe sections) 

- tw: web thickness 

- tf: flange thickness 

- A: area of the section 

- Jz: moment of inertia with respect to horizontal axis 

- Jy: moment of inertia with respect to vertical axis 

- Wez: elastic strength modulus with respect to horizontal axis 

- Wey: elastic strength modulus with respect to vertical axis 

- Wpz: plastic strength modulus with respect to horizontal axis 

- Wpy: plastic strength modulus with respect to vertical axis 

- Avz: shear area with respect to horizontal axis (local z) 

- Avy: shear area with respect to horizontal axis (local y) 

- gap: horizontal distance for double sections (eg. double L or double C). 

The property name can be followed by square brackets containing the unit of measure (eg. “h [cm]”).  

The Type columns specifies the shape of the section. Insert: 

- 0 for unknown or generic 

- 1 for rectangular 

- 2 for circular 

- 3 for C shape 

- 4 for T shape 

- 5 for double-T o I 

- 6 for L shape 

- 7 for box 

- 8 for pipe 

- 9 for double L 

- 10 for double C. 

The file must be placed in the “data” folder and its extension must be *.nfs. 

 

4.3. Library of sections defined by points 

Sections defined by points can be inserted in a *.nfs file like in the previous case, but with the following fields: 

Name;Code;PointsXf1 [mm];PointsYf1 [mm];PointsXe2 [mm];PointsYe2 [mm];PointsXf3 [mm];PointsYf3 [mm];Class;OffsetX [mm];OffsetY 
[mm];alphaLT;alphay;alphaz;Jw [mm^4] 
TestSect;custom;0,20,20,0;0,0,20,20;4,8,8,4;4,4,8,8;0;0;3;0;0;0.76;0.76;0.76;0 
…  

 

First 2 columns are mandatory, and value of Code column must be set to “custom”. Series of points can be 

whichever needed, by following this codification for columns names: 

PointsXpN [units];PointsYpN [units]; 
 

in which p is equal to “f” for filled figures and “e” for holes; N is the progressive number of series, the same for filled 

and empty shapes. All the columns after section offsets are inserted in section custom values (e.g. 

alphaLT;alphay;alphaz;Jw). 
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4.4. Custom verifications 

It is possible to customize the list of verifications with the notation described in the following. The text file containing 

checking can be placed in the “ verification” folder in the program installation directory and must have the “. nvv” 

extension (see for example trusses.nvv).  

Such file can be edited with: 

- Notepad++, with the setting for the syntax highlight that can be found in the “ verification” folder ( file 

NextFEMVerifications.xml); 

- Visual Studio Code with Custom Coloring plugin for syntax highlight. Setting for this plugin are in the file 

NextFEMverification_vsCode.json contained in the folder “ verification” as well. 

 

The checking engine supports the code execution in blocks. Each block is delimited by the identifiers as in the 

following example and must the named with a floating point number (0.6). 

$$0.6 

# this is a comment 

execif(SecType==1,1.0) 

$! 

To call each block, the following keywords are available: 

- exec(0.6) : executes the code block named 0.6 

- execif(condition, 0.6): executes the code block named 0.6 if condition is true; 

- execwhile(condition, 0.6): executes the code block named 0.6 while condition is true. The variable exitdo 

equal to 1 within the code block forces the exit. Limited to 10000 cycles. 

Formulas can be written using the following operators/functions: 

Addition: + 

Subtraction: - 

Multiplication: * 

Division: / 

Modulo: % 

Exponentiation: ^ 

Less than: < 

Less than or equal: <= or ≤  

More than: > 

More than or equal: >= or ≥  

Equal: == 

Not Equal: != or ≠  

Sine: sin 

Cosine: cos 

Arcsine: asin 

Arccosine: acos 

Tangent: tan 

Cotangent: cot 

Arctangent: atan 

Arc cotangent: acot 

Natural logarithm: loge 

Common logarithm: log10 

https://notepad-plus-plus.org/
https://code.visualstudio.com/
https://marketplace.visualstudio.com/items?itemName=altrue.CustomColoring
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Logarithm: logn 

Square root: sqrt 

Conditional key: if(var<var2,1,0) 

Boolean operator: and(cond1,cond2) 

Boolean operator: or(cond1,cond2) 

Boolean operator: not(cond) 

 

The hardcoded variables are: 

- Model units handling 

o unitconv: converts between units. Usage: unitconv(oldUnits,newUnits,Value). 

Example: Eps=sqrt(235/unitconv(model_S,MPa,fk)) 

converts fk from stress units in the model  to MPa 

o rcsect: calculates resisting moments of a RC section, storing them in Mry and Mrz. Usage: 

rcsect(N,Myy,Mzz) 

o skipItem: if =1, skips the subsequent checking. To be used only in the time-dependent load 

cases (for example, linear dynamic analysis) 

o model_L: placeholder for the length unit in the model 

o model_F: placeholder for the force unit in the model 

o model_FL: placeholder for the force per length unit in the model 

o model_T: placeholder for the temperature unit in the model 

o model_M: placeholder for the mass unit in the model 

o model_S: placeholder for the stress unit in the model 

o isVarDefined(var): checks if a variable is defined (1) or not (0) 

o Halt: stops the execution; 

o addUtable:  adds an user table at runtime, and returns the ID of the table. Usage: 

addUtable(numColumns, columnsHeaders, data by row including row header). Example: 

tid=addUtable(3,1,2,3,100,4,5,6,101,4,5,6,102,4,5,6,103,4,5,6)  

adds the following table: 

  1 2 3 

100 4 5 6 

101 4 5 6 

102 4 5 6 

103 4 5 6 

o UtableAt: returns the value at i, j of a table. Usage: UtableAt(table ID,i,j) 

o UtableInterpValues:  gives the bilinear interpolation for the table. Usage: 

results=UtableInterpValues(table ID, value on row headers, value on column headers). 

Example: res1= UtableInterpValues(tid,101.3,2.5) gives 5.5 as a result. 

o addRebar: adds longitudinal rebar to the current element.  

The function returns 0 if it fails or design material cannot be found. 

Usage: addRebar(zCoord, yCoord, rebarArea, design material ID, startAt [0,1), endAt (0,1] ).  

Example: addRebarL(40,40,201.0,2,0,1) 

adds a rebar of area 201.0 at position 40, 40 from the bottom left corner of the section, for the 

whole element. 

o addStirrups: adds stirrups to the current element.  

The function returns 0 if it fails or design material cannot be found. 

Usage: addStirrups(legs in Y, legs in Z, single bar area, spacing, design material ID, startAt [0,1), 

endAt (0,1] ). 
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Example: addStirrups(2, 2, 50.0, 200, 2, 0,1) 

adds 2-by-2 legs stirrups, each one of area 50.0, at 200 of spacing, for the whole element. 

o clearRebar: clear all rebar, including stirrups, in the current element. 

o getBarDiam: gets the minimum diameter of a longitudinal bar required to satisfy the given 

area. The output is in mm. Example: getBarDiam(2.01) # for a model in cm, returns 16. 

o getStirrupDiam: gets the minimum diameter of a stirrup bar required to satisfy the given 

area. The output is in mm. Example: getStirrupDiam(0.5) # for a model in cm, returns 8. 

o TranslateMomentZZ: gives maximum and minimum moments around z local axis for the 

given position, translated by a quantity delta. Syntax: TranslateMomentZZ(position, delta). The 

argument position is contained in the built-in dataset for elements in the variable pos. This 

function returns or overwrite the variables Mzzmax and Mzzmin. 

o TranslateMomentYY: gives maximum and minimum moments around y local axis for the 

given position, translated by a quantity delta. Syntax: TranslateMomentYY(position, delta). The 

argument position is contained in the built-in dataset for elements in the variable pos. This 

function returns or overwrite the variables Myymax and Myymin. 

o FireSectionStrength: loads a thermal map of a section and use it to estimate element 

strength. It is available in the FireSafe module. The filename containing thermal results for the 

station must be saved inside the “fireSect” key in custom properties of the element. Syntax:   

FireSectionStrength(station,N,Myy,Mzz). The argument station is the checking station, typically 

from 1 to 5. 

o round: round a floating point number to the nearest integer. Ex. round(12.6) returns 13.0. 

o ceil: round up a floating point number. Ex. ceil(12.3) returns 13.0. 

o floor: round down a floating point number. Ex. floor(12.6) returns 12.0. 

 

- Built-in general dataset: 

o ServType: indicates if the current serviceability combination is characteristic (rare) (1), 

frequent (2) or quasi-permanent (2). The value is 0 if the combination is not of serviceability 

type. 

o Seismic: indicates if the current combination is seismic (1) or not (0). The value 1 is always 

associated to ServType=0. 

o time: current time. 

 

- Built-in dataset for elements: 

o A: Area 

o Jz: Moment of inertia around z-axis 

o Jy: Moment of inertia around y-axis 

o Jmin: Minimum moment of inertia  

o Jt: Torsional Inertia 

o D: Diameter of circular cross sections 

o Di: Inner diameter of pipe cross sections 

o te: Thickness of pipe cross sections 

o b: Base for any other cross sections 

o h: Height for any other cross sections 

o tw: web thickness 

o tf1: thickness of bottom flange 

o tf2: thickness of upper flange 

o t: thickness for planar sections 

o N: Axial force of the current section of a beam 

o Vy: Shear force along y direction of the current section of a beam 
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o Vz: Shear force along z direction of the current section of a beam 

o Mt: Twisting moment of the current section of a beam 

o Myy: Moment around y local axis of the current section of a beam 

o Mzz: Moment around z local axis of the current section of a beam 

o rMyIJ: ratio between Myy at end I and at end J of the beam 

o rMzIJ: ratio between Mzz at end I and at end J of the beam 

o MmaxY: maximum moment around y axis for the whole element or member 

o MmaxZ: maximum moment around z axis for the whole element or member 

o MminY: minimum moment around y axis for the whole element or member 

o MminZ: minimum moment around z axis for the whole element or member 

o Em: material Young modulus 

o Gm: material shear modulus 

o NIm: material Poisson’s ratio 

o fk: material characteristic strength 

o WelZ: section modulus for z axis 

o WelY: section modulus for y axis 

o WplZ: plastic section modulus for z axis 

o WplY: plastic section modulus for y axis 

o iz: radius of inertia for z axis 

o iy: radius of inertia for y axis 

o imin: minimum radius of inertia 

o SecType: 1=beam, 2=planar, 0=unknown 

o SecBeamType: 0=unknown, 1=rectangular, 2=circular, 3=Cshape, 4=Tshape, 

5=DoubleTshape, 6=Lspahe, 7=box, 8=pipe 

o MatType: type of material. Steel 1, Aluminium 2, Concrete 3, Timber 4, Masonry 5, Fragile in 

tension 6, unknown 0. 

o dx: axial relative displacement along beam axis 

o dy: transversal deflection in local direction y 

o dz: transversal deflection in local direction z 

o L0yy: buckling length for bending around y local axis 

o L0zz: buckling length for bending around z local axis 

o L0: maximum buckling length between L0yy and L0zz 

o pos: of the current section of a beam, in model units 

o LvyI: contraflexure length from end I, ratio Myy/Vz in station 1 

o LvyJ: contraflexure length from end J, ratio Myy/Vz in station 5 

o LvzI: contraflexure length from end I, ratio Mzz/Vy in station 1 

o LvzJ: contraflexure length from end J, ratio Mzz/Vy in station 5 

o fxx: force in x local direction (element centre) 

o fyy: force in y local direction (element centre) 

o fxy: shear force in xy direction (element centre) 

o fzz: force in z local direction (element centre) 

o fxz: shear force in xz direction (element centre) 

o fyz: shear force in yz direction (element centre) 

o mmxx: moment around x local direction (element centre) 

o mmyy: moment around y local direction (element centre) 

o mmxy: moment around xy direction (element centre) 

o mmzz: moment around z local direction (element centre) 

o mmxz: moment around xz direction (element centre) 

o mmyz: moment around yz direction (element centre) 
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o time: current time step 

o temp: average element temperature in the current step 

o isWall: if wall groups is defined for the current planar element returns 1, 0 otherwise. 

o Column: if the current beam element is vertical returns 1, 0 otherwise. It is not defined for 

other types of elements. 

 

- Built-in dataset for nodal results: 

o dx: nodal displacement in X direction 

o dy: nodal displacement in Y direction 

o dz: nodal displacement in Z direction 

o rx: nodal rotation around X axis 

o ry: nodal rotation around Y axis 

o rz: nodal rotation around Z axis 

o vx: nodal velocity in X direction 

o vy: nodal velocity in Y direction 

o vz: nodal velocity in Z direction 

o vrx: nodal velocity around X axis 

o vry: nodal velocity around Y axis 

o vrz: nodal velocity around Z axis 

o ax: nodal acceleration in X direction 

o ay: nodal acceleration in Y direction 

o az: nodal acceleration in Z direction 

o arx: nodal acceleration around X axis 

o ary: nodal acceleration around Y axis 

o arz: nodal acceleration around Z axis 

o Rex: nodal reaction in X direction 

o Rey: nodal reaction in Y direction 

o Rez: nodal reaction in Z direction 

o Rerx: nodal reaction around X axis 

o Rery: nodal reaction around Y axis 

o Rerz: nodal reaction around Z axis 

o sxx: nodal stress in X direction 

o syy: nodal stress in Y direction 

o sxy: nodal shear stress in XY direction 

o szz: nodal stress in Z direction 

o sxz: nodal shear stress in XZ direction 

o syz: nodal shear stress in YZ direction 

o fxx: nodal force in X direction 

o fyy: nodal force in Y direction 

o fxy: nodal shear force in XY direction 

o fzz: nodal force in Z direction 

o fxz: nodal shear force in XZ direction 

o fyz: nodal shear force in YZ direction 

o mxx: nodal moment around X direction 

o myy: nodal moment around Y direction 

o mxy: nodal moment around XY direction 

o mzz: nodal moment around Z direction 

o mxz: nodal moment around XZ direction 

o myz: nodal moment around YZ direction 
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o time: current time step 

o temp: nodal temperature in the current step. 

 

  



91 
 
 

 

5. Getting started and validation 

5.1. Tutorial One 

This tutorial will show how to model a 5 metres long fixed-ended beam, loaded with concentrated loads of 10kN in 

directions x, y and  z in the middle of its span. The results from NextFEM Designer (Frame forces and displacement) 

are compared with hand calculations. 

 WARNING: Both flexural and shear deformations are considered. To enable this option, click on 

Tools>Option>Solver and check the Include shear deformations in beam elements tick under the 

OOFEM preferences box 

The following sequence of operations are needed to create the model: 

1. Set the Units: N for force and mm for length. 

 

2. Define the Material properties: 

o Name: Concrete; 

o E=30000 N/mm2; 

o Nu=0.3 

o Fk=25 N/mm 

o Weight=2.5e-5 N/mm3; 

o Mass=2.55e-9 N/mm2/g 
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3. Define the Section properties: 

o b=300 mm (z direction); 

o h=500mm (y direction); 

 

4. Define the Loads cases: Only one load case called Qk1 is considered 
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5. Insert the Geometric properties using Node by Coordinates: 

o L=5000 mm; 

o Distance from fixed end to loads=2500 mm; 

 

6. Insert the beams using the Beam command. 

 

7. Assign the boundary conditions using the Restraints command: fix all DoFs for nodes 1 and 3. 

 

8. Assign the material using the Assign>Material command at the beams by selecting them and then 

click on Assign to selected elements 
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9. Assign the section using the Assign>Section command at the beams by selecting them and then 

click on Assign 

 

10. Assign the point load to the node number 2. 

o Px=10000 N; 

o Py=10000 N; 

o Pz=-10000 N. 

 

11. Run the analysis. 

 

- NextFEM Designer’s Results: 

o Displacement in x direction: Node 2=0.002778mm 
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o Displacement in y direction: Node 2=0.2016mm 

 

o Displacement in z direction: Node 2=-0.00781 mm 
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o Moment Diagram: Values from Results>Extract Data 

▪ Mzz 

 

▪ Myy 
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o Shear Diagram: 

 

▪ Vy 

 

▪ Vz 
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o Normal forces Diagram:  

 

o Internal displacements in y direction: values from Results>Extract data 

Position [mm] Displacement [mm] 

0 0 

281.8 0.00778 

1250 0.1008 

2218 0.1938 

2500 0.2016 

2500 0.2016 

2781.8 0.1938 
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3750 0.1008 

4718 0.00778 

5000 0 

 

o Internal displacements in z direction: values from Results>Extract data 

Position [mm] Displacement [mm] 

0 0 

281.8 -0.003424 

1250 -0.03906 

2218 -0.07469 

2500 -0.07811 

2500 -0.07811 

2781.8 -0.07469 

3750 -0.03906 

4718 -0.003424 

5000 0 

 

- Hand Calculations: 

o Section properties 
2

3
4

3
4

150000

3125 6
12

1125 6
12

=  =

= =

= =

y

z

A b h mm

bh
J e mm

hb
J e mm

 

o Moment diagram: 

▪ Mzz 

max 6250000
8

zP lM Nmm= = ; min 6250000
8

zP lM Nmm= − = −  

▪ Myy 

max 6250000
8

yP l
M Nmm= = ; 

min 6250000
8

yP l
M Nmm= − = −  

o Shear Diagram: 

▪ Vy 

max 5000
2

zPV N= = ; 
min 5000

2

zPV N= − = −  

▪ Vz 

max 5000
2

yP
V N= = ; min 5000

2

yP
V N= − = −  

o Axial force Diagram: 

max 5000
2

xPN N= = ; min 5000
2

xPN N= − = −  

o Displacement in x direction: Node2 
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max

2,

( / 2)
0.00278x

N l
u mm

EA
= =  

o Displacement in y direction: Node 2 

3

2,

1
0.201568

192 4

y y

y

z

P l P l
u mm

EJ GA
= + =  

o Displacement in z direction: Node 2 

3

2,

1
0.07811

192 4

z z

z

y

P l P l
u mm

EJ GA
= + = −

 

o Displacement in y direction: internal point at the coordinate x 

2

x,

3
2

1 2

24 2

y
y

y

z

P x l x
P x

u
EJ GA



 
− 

 
= + for 0 / 2x L   

( ) ( )
2

x,

2
1 2

24 2

y
y

y

z

L
P L x x

P L x
u

EJ GA


 
− −  − 

= +  for / 2L x L   

Position [mm] Displacement [mm] 

0 0 

281.8 0.00778 

1250 0.1008 

2218 0.1938 

2500 0.2016 

2500 0.2016 

2781.8 0.1938 

3750 0.1008 

4718 0.00779 

5000 0 

 

o Displacement in z direction: internal point at the coordinate x 

2

x,

3
2

1 2

24 2

z

z

z

y

P x l x
P x

u
EJ GA



 
− 

 
= +  for 0 / 2x L   

( )
( )

2

x,z

2
1 2

24 2

z
z

y

L
P L x x

P L x
u

EJ GA


 
− −  − 

= +  for / 2L x L   

Position [mm] Displacement [mm] 

0 0 

281.8 -0.003425 



101 
 
 

1250 -0.03906 

2218 -0.07468 

2500 -0.07811 

2500 -0.07811 

2781.8 -0.07469 

3750 -0.03906 

4718 -0.003429 

5000 0 

 

 

5.2. Tutorial Two 

The second tutorial consists in a cantilever beam loaded with points load in directions y and z. The output results of 

NextFEM Designer (Frame forces and displacement) are compared with hand calculations. 

Case a 

 Only flexural deformations are considered. 

- Units: N for forces and mm for lengths. 

- Material Properties: 

o Name: Concrete; 

o E=30000 N/mm2; 

o Nu=0.3 

o Fk=25 N/mm 

o Weight=2.5^10-5 N/mm3; 

o Mass=2.55^10-9 N/mm2/g 

- Section properties: 

o B=300 mm (z direction); 

o H=500mm (y direction); 

- Geometric properties: 

o L=2500 mm; 

- Loads: 

o Py=5000 N; 

o Pz=-10000 N. 
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- NextFEM Designer’s results: 

o Displacement in x direction: Node 2=0.00mm 

 

o Displacement in y direction: Node 2=0.7716mm 
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o Displacement in z direction: Node 2=-0.5556mm 

 

o Moment Diagram: Values from Results>Extract Data 

▪ Mzz 
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▪ Myy 

 

o Shear Diagram: 

▪ Vy 
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▪ Vz 

 

o Internal displacement in y direction: values from Results>Extract data 

Position [mm] Displacement [mm] 

0 0 

281.8 0.01415 

1250 0.2411 

2218 0.6417 

2500 0.7716 

 

o Internal displacement in z direction: values from Results>Extract data 

Position [mm] Displacement [mm] 
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0 0 

281.8 -0.01019 

1250 -0.1736 

2218 -0.4620 

2500 -0.5556 

 

- Hand Calculations: 

o Moment diagram: 

▪ Mzz 

max 25000000zM P l Nmm= = ; 

▪ Myy 

max 12500000yM P l Nmm= =  

o Shear Diagram: 

▪ Vy 

max 10000zV P N= = ;  

▪ Vz 

max 5000yV P N= = ;  

o Axial force Diagram: 

max 0N N= ;  

o Displacement in x direction: Node 2 

2, 0xu =  

o Displacement in y direction: Node 2 

3

2,

1
0.77160

3

y

y

z

P l
u mm

EJ
= =  

o Displacement in z direction: Node 2 

3

2,

1
0.0.5556

3

z

z

y

P l
u mm

EJ
= = −  

o Displacement in y direction: point at coordinate x 

( )2

x,

31

6

y

y

z

P x l x
u

EJ

−
=  

Coordinate x [mm] Displacement [mm] 

0 0 

281.8 0.01415 

1250 0.2411 

2218 0.6416 

2500 0.7716 

 

o Displacement in z direction: point at coordinate x 
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( )2

x,

31

6

z

z

y

P x l x
u

EJ

−
=  

Coordinate x [mm] Displacement [mm] 

0 0 

281.8 -0.01019 

1250 -0.1736 

2218 -0.4620 

2500 -0.5556 

 

Case b 

 Both flexural and shear deformations are considered. To enable this option, click on 

Tools>Option>Solver and check the Include shear deformations in beam elements tick under the 

OOFEM preferences box 

- Units: N for forces and mm for lengths. 

- Material Properties: 

o Name: Concrete; 

o E=30000 N/mm2; 

o Nu=0.3 

o Fk=25 N/mm 

o Weight=2.5^10-5 N/mm3; 

o Mass=2.55^10-9 N/mm2/g 

- Section properties: 

o B=300 mm (z direction); 

o H=500mm (y direction); 

- Geometric properties: 

o L=2500 mm; 

- Loads: 

o Py=5000 N; 

o Pz=-10000 N. 
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- NextFEM Designer’s results:  

o Displacement in x direction: Node 2=0.00mm 

 

o Displacement in y direction: Node 2=0.7803mm 

 

 

o Displacement in z direction: Node 2=-0.5729mm 
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o Moment Diagram: Values from Results>Extract Data 

▪ Mzz 

 

▪ Myy 
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o Shear Diagram: 

▪ Vy 

 

▪ Vz 
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o Internal displacement in y direction: values from Results>Extract data 

Position [mm] Displacement [mm] 

0 0 

281.8 0.01513 

1250 0.2455 

2218 0.6494 

2500 0.7803 

 

o Internal displacement in z direction: values from Results>Extract data 

Position [mm] Displacement [mm] 

0 0 

281.8 -0.01214 

1250 -0.1823 

2218 -0.4774 

2500 -0.5729 

 

- Hand Calculations: 

o Moment diagram: 

▪ Mzz 

max 25000000zM P l Nmm= = ; 

▪ Myy 

max 12500000yM P l Nmm= =  

o Shear Diagram: 
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▪ Vy 

max 10000zV P N= = ;  

▪ Vz 

max 5000yV P N= = ;  

o Axial force Diagram: 

max 0N N= ;  

o Displacement in x direction: Node 2 

2, 0xu mm=  

o Displacement in y direction: Node 2 

3

2,

1
0.7803

3

y y

y

z

P l P l
u mm

EJ GA
= + =  

o Displacement in y direction: point at coordinate x 

( )2

x,

31

6

y y

y

z

P x l x P x
u

EJ GA


−
= +  

Coordinate x [mm] Displacement [mm] 

0 0 

281.8 0.01513 

1250 0.2455 

2218 0.6493 

2500 0.7803 

 

o Displacement in z direction: Node 2 

3

2,

1
0.5729

3

z z

z

y

P l P l
u mm

EJ GA
= + = −  

o displacement in z direction: point at coordinate x 

( )2

x,

31

6

z z

z

y

P x l x P x
u

EJ GA


−
= +  

Coordinate x [mm] Displacement [mm] 

0 0 

281.8 -0.01214 

1250 -0.1823 

2218 -0.4773 

2500 -0.5729 
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5.3. Tutorial Three 

The third tutorial consists in a cantilever beam loaded with points load in direction y with modelled by shell elements 

(Mindlin-Reissner theory). The output results of NextFEM Designer (Frame forces and displacement) are compared 

with hand calculations. 

 Only flexural deformations are considered. 

- Units: N for forces and mm for lengths. 

- Material Properties: 

o Name: Concrete; 

o E=30000 N/mm2; 

o Nu=0.3 

o Fk=25 N/mm 

o Weight=2.5^10-5 N/mm3; 

o Mass=2.55^10-9 N/mm2/g 

- Section properties: 

o B=300 mm (y direction); Planar section; 

- Geometric properties: 

o L=5000 mm; 

- Loads: 

o Py=5000 N; 

o Pz=10000 N; 

- Mesh size: 250x250 mm 

 

- NextFEM Designer’s Results:  

o Displacement in x direction: Node 2=0.00mm 
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o Displacement in y direction: Node 2=0.6250 mm 

 

o Displacement in z direction: Node 2=-0.5062mm 
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- Comparison with hand Calculations (see tutorial two): 

o Displacement in y direction 

▪ Hand Calculation: 0.77160mm 

▪ NextFEM designer: 0.6250mm 

▪ Percent difference 19% 

o Displacement in z direction: 

▪ Hand Calculation: -0.5556mm 

▪ NextFEM designer: -0.5062mm 

▪ Percent difference: 9% 

Note that the difference is due to the choice of the mesh size. 

5.4. Tutorial Four 

The fourth tutorial consists in a cantilever beam loaded with distributed loads in directions x, y and z. The output of 

NextFEM Designer (Frame forces and displacement) is compared with hand calculations. 

 

 Only flexural deformations are considered. 

- Units: N for forces and mm for lengths. 

- Material Properties: 
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o Name: Concrete; 

o E=30000 N/mm2; 

o Nu=0.3 

o Fk=25 N/mm 

o Weight=2.5^10-5 N/mm3; 

o Mass=2.55^10-9 N/mm2/g 

- Section properties: 

o B=300 mm (y direction); 

o H=500mm (z direction); 

- Geometric properties: 

o L=5000 mm; 

- Loads properties: 

o qy=1 N/mm; 

o qz=-1 N/mm; 

o qx=-1 N/mm. 

 

- NextFEM Designer’s Results:  

o Displacement in x direction: Node 6=-0.00278mm  

 

o Displacement in y direction: Node 6=2.315mm 
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o Displacement in z direction: Node 6=-0.8333mm 

 

o Moment Diagram: Values from Results>Extract Data 

▪ Mzz max: node 1: 125000000000 Nmm 

 

▪ Myy max: node 1: 125000000000 Nmm 
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o Shear Diagram: 

▪ Vy 

 

▪ Vz 

 

- Hand Calculations: 

o Moment diagram: 

▪ Mzz 
2

max 125000000000
2

zq lM Nmm= = ; 

▪ Myy 
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2

max 125000000000
2

yq l
M Nmm= = ; 

o Shear Diagram: 

▪ Vy 

max 5000zV q l N= = ;  

▪ Vz 

max 5000yV q l N= = ;  

o Axial force diagram: 

max 5000xN q l N= = ;  

o Max Displacement in x direction: Node 6 

2

6, 0.00278
2

x

x

q l
u mm

EA
= =  

o Max Displacement in y direction: Node 6 

4

6 2.315
8

y

y

y

q l
u mm

EJ
= =  

o Max Displacement in z direction: Node 6 

4

6, 0.8333
8

z

z

z

q l
u mm

EJ
= = −  

5.5. Tutorial Five 

The fifth tutorial consists in a modal analysis of a 3D wooden frame-building .  The output of NextFEM Designer 

(modes of vibration) is compared with the output of SAP2000®. 

 

 Only flexural deformations are considered. 

- Units: kN for forces and m for lengths. 

- Material Properties: 
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o Name: GL24H; 

o E=9.40^10+6 kN/m2; 

o Nu=0.3 

o Weight=3.8 kN/m3; 

o Mass=0 kN/m3/g 

- Section properties: 

o B=300 mm (y direction); 

o H=500mm (z direction); 

- Geometric properties: 

o Lx=3 m; 

o Ly=4m; 

o Lz=2m; 

- Mass properties: at every nodes of the 1st storey 

o my=2.5 kN/g; 

o mz=-2.5 kN/g; 

o mx=-2.5 kN/g 

 

- NextFEM Designer’s Results:  

o First mode: 

 

o Second mode: 
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o Third mode: 

 

- SAP2000® results: 

o First mode: 
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o Second mode: 

 

o Third mode: 

 

The test model,  calculated with two different programs, exhibits comparable results. 

5.6. Tutorial Six 

The sixth tutorial consists in a response spectrum analysis of a 3D wooden frame-building, as showed in tutorial five.   

The acceleration spectrum employed is generated from inside the Functions form,  and it is consistent with the 

Eurocode 8 Type 1 spectrum, on soil A and with PGA 0.35g. 

 

The Response Spectrum linear dynamic analysis is performed separately in each spatial direction. 
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 WARNING: all the results given by a ResponseSpectrum analysis must be interpreted without sign. 

 

 

5.7. Tutorial Seven 

The sixth tutorial consists in a buckling analysis of a simply supported concrete column. The output of NextFEM 

Designer (i.e. the eigenvalues representing the load multipliers) is compared with the results computed by the 

Eulerian instability theory. The column is meshed into 5 elements of equal length. 
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 Only flexural deformations are considered. 

- Units: kN for forces and m for lengths. 

- Material Properties: 

o Name: C25/30; 

o E=3.15e+6 kN/m2; 

o =0.2 

o Weight =25 kN/m3; 

o Mass =2.5 kN/m3/g 

- Section properties: 

o B=100 mm (z); 

o H=200 mm (y); 

- Geometric properties: 

o Ltot=3.0 m; 

- Loads: 

o Qz=-1 kN; 

 

- NextFEM Designer’s Results:  

o First mode: 
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o Second mode: 

 

o Third mode: 



126 
 
 

 

 

o Fourth mode: 

 

o Fifth mode: 
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- Manual calculation: 

o The critical load is computed as come
( )

2

2
/

cr

EJ
P

l n
=   with 1,2,3,...n = , and the inertia J 

of the direction of inflection. 

o Section inertia: 

3 6 41
16.7 10

12
yyJ hb mm= =    

3 6 41
66.7 10

12
zzJ bh mm= =   

o Theoretical results: 

Bending around yy Bending around zz 

( )
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NextFEM Designer’s results are in agreement with the theoretical results.  

  



128 
 
 

6. License Terms 

END USER LICENSE AGREEMENT 
 
By using the software provided by NextFEM SRLS, user explicitly agreed to the following terms and conditions. The contents of 
NextFEM website and of the supplied software, including the following license terms, could be changes and/or updated at any 
time. By using the software supplied by NextFEM SRLS or our website, the privacy policy of NextFEM SRLS, published on 
https://www.nextfem.it/it/privacy-policy/, is accepted. 
 
Art. 1 – User license – 
 
1. On the basis of the following terms and conditions, NextFEM SRLS, in the person of its in office pro tempore legal representative 
(specified as “Company” or “Licensor” in the following), grants to the Customer (“User” or “Licensee” in the following) the  license 
to use the software (or “Program” or “Programs” in the following) provided by NextFEM SRLS, for PC and for Windows® operating  
system, including manuals and documentation. The license hereby granted is not exclusive and not transferable in any case. 
 
2. The present agreement does not transfer to the Licensee the source code of the supplied software, neither the logic and/or 
design documentation. 
 
Art. 2 – Duration – Agreement termination – 
 
1. The present agreement is valid for one year, starting from the license issue date. At the end of the year, this agreement will be 
considered automatically rescinded, unless a renewal request by the Customer is received by NextFEM SRLS via email at 
licensing@nextfem.it at least 30 days before the license expiration, or unless the Customer buys the renewal. Different conditions 
may apply for Educational licenses. 
 
2. NextFEM SRLS has the right to terminate earlier the present agreement due to gross negligence or wilful misconduct of the 
Customer and/or for violations of the present agreement. Termination will be communicated via email to the address supplied by 
the Customer during registration onto the Company’s website. In any case, the Licensor has the right to the compensation for 
damage. 
 
Art. 3 - License delivery - 
 
1. The free software provided by NextFEM SRLS which is freely available can be independently downloaded by the Customer from 
the site nextfem.it. 
 
2. The paid software provided by NextFEM SRLS which is subjected to a fee can be independently downloaded by the Customer 
from the site nextfem.it. License request are fulfilled by the Licensor in the indicative and not binding term of 7 days after the 
reception of the payment. Different conditions may apply for Educational licenses. 
 
3. In any case, NextFEM SRLS is not responsible of any damage directly or indirectly connected to delays not dependent on its will 
during the release of the license. 
 
Art. 4 – Installation - 
 
1. NextFEM software is auto-installing. Once the installation is performed, the software is considered as accepted by the Customer. 
 
2. Any other service (e.g. installation, verification, assistance requested by the Customer to let his employees to use NextFEM 
software) will be performed by NextFEM SRLS after a Customer’s request and in any case after a quotation made by NextFEM Srls  
and its acceptance by the Customer. 
 
3. The Customer is solely responsible that his technological equipment (hardware and software) meets the minimum and essential 
requirements to install and use the software, as indicated in the users’ manual included in the program.  
 
Art. 5 – Programs usage – 
 
1. The Customer must use NextFEM software for lawful and legal purposes. 
 
2. The Customer undertakes to not remove or alter any trademarks, serial number or other information related to right reservation, 
which are included in software produced by NextFEM SRLS, even after the termination of the present agreement. 
 

https://www.nextfem.it/it/privacy-policy/
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3. According to the Italian law art. 64 ter Law 22nd of April 1941, n. 633 as amended and supplemented and art. 5 par. 2 Directive 
2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and supplemented, it is allowed to the 
Licensee Customer, having the right to use a copy of the software produced by NextFEM SRLS, to make a back-up copy of the 
software and of the included documentation, so far as it is necessary for that use. 
 
4. According to the Italian law art. 64 bis, lett. a) and b) ,64 ter Law 22nd of April 1941, n. 633 as amended and supplemented and 
art. 4 par. 1 lett. a) and b) Directive 2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and 
supplemented, it is explicitly forbidden to the Customer the permanent or temporary reproduction of the software produced by 
NextFEM SRLS and of the included documentation, by any means and in any form, in part or in whole, without the authorisation 
by the right-holder. In so far as loading, displaying, running, transmission or storage of the aforementioned software necessitate 
such reproduction, even such acts shall be subject to authorisation by the right-holder. At the same conditions and with the same 
restrictions, it is equally forbidden to the Customer the translation, adaptation, arrangement and any other alteration of the 
software produced by NextFEM SRLS and of the included documentation and the reproduction of the results thereof, without 
prejudice to the rights of the person who alters the program. 
 
5. The acts of the aforementioned paragraphs 2 and 3, even when they are necessary for the use of the aforementioned software 
by the lawful Licensee Customer in accordance with its intended purpose, including for error correction, are subjected to the 
authorisation by the right-holder. 
 
6. According to the Italian law art. 64 ter, subparagraph 3 Law 22nd of April 1941, n. 633 as amended and supplemented and art. 5 
par. 3 Directive 2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and supplemented, it is 
allowed to the Licensee Customer to observe, study or test the functioning of the software produced by NextFEM SRLS and of 
which he holds the License, in order to determine the ideas and principles which underlie any element of the program if he does 
so while performing any of the acts of loading, displaying, running, transmitting or storing the program which he is entitled to do. 
 
7. According to the Italian law art. 64 quater Law 22nd of April 1941, n. 633 as amended and supplemented and art. 6 Directive 
2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and supplemented, the previous 
authorisation of NextFEM SRLS shall not be required where reproduction of the code and translation of its form within the meaning 
of art. 64bis, lett. a) and b) Law 22nd of April 1941, n. 633 as amended and supplemented and of points (a) and (b) of Article 4 par.1 
are done to modify the form of the code and are indispensable to obtain the information necessary to achieve the interoperability 
of an independently created computer program with other programs, provided that the following conditions are met: 
(a) those acts are performed by the Licensee or by another person having a right to use a copy of a program, or on their behalf by 
a person authorised to do so; 
(b) the information necessary to achieve interoperability has not previously been readily available to the persons referred to in 
point (a);  
(c) those acts are confined to the parts of the original program which are necessary in order to achieve interoperability. 
 
8. The provisions of preceding paragraph 7 shall not permit the information obtained through its application: 
(a) to be used for goals other than to achieve the interoperability of the independently created computer program; 
(b) to be given to others, except when necessary for the interoperability of the independently created computer program; 
(c) to be used for the development, production or marketing of a computer program substantially similar in its expression, or for 
any other act which infringes copyright. 
 
9. In accordance with the provisions of the Berne Convention for the protection of Literary and Artistic Works, enacted in Italy with 
the Italian law 20th of June 1978, n. 399 as amended and supplemented, the provisions of article 64 quater Law 22nd of April 1941, 
n. 633 as amended and supplemented and art. 6 of Directive 2009/24/EC of the European Parliament and of the Council of 23rd 
April 2009 as amended and supplemented may not be interpreted in such a way as to allow its application to be used in a manner 
which unreasonably prejudices the right-holder's legitimate interests or conflicts with a normal exploitation of the computer 
program. 
 
Art. 6 – Property – Transfer prohibition – 
 
1. The software provided by NextFEM SRLS and the included documentation remain exclusive property of NextFEM SRLS. The 
Customer is explicitly forbidden to distribute products of NextFEM SRLS or copies to anyone or to sell them or assign them in 
license to third parts or to lease them, or in any case to allow others to use the programs, either in exchange for payment or not. 
In these cases, NextFEM SRLS can revoke the user's license of the free program or of any of the paid modules at any time. 
 
2. This clause will remain in force even after the rescission or the termination to any title of this contract. 
 
Art. 7 – Right holders – Secret – Modifications – 
 
1. The software provided by NextFEM SRLS, the included documentation,  the program code, its layout, the structures and the 
program files organization, the program name, the Company logo and any other representation form within the software are 
subjected to copyright; this one, and any rights coming from it or in any way connected to the copyright are property of NextFEM 
SRLS. Other trademarks belong to the respective owners. 
 
2. The Customer is required to keep secret the content of the software provided by NextFEM SRLS and the included documentation, 
and to protect NextFEM SRLS and his suppliers’ rights; in particular, the Customer is required either to make no modification s to 
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the software provided by NextFEM SRLS or to incorporate it entirely or in part in other software without preventive written 
authorisation by NextFEM SRLS, without prejudice to current mandatory legislation on the matter. In these cases, NextFEM SRLS 
can revoke the user's license of the free program or of any of the paid module at any time. 
 
3. This clause will remain in force even after the termination or the expiration in whatever manner of this agreement. 
 
Art. 8 – Fee – Solve et repete – 
 
1. NextFEM SRLS provides the software “as is” and is not obliged to provide maintenance, support, updates, improvements or 
changes. Different conditions may apply to paid software and for Education licenses. 
 
2. To ensure the continuity of the license and of paid modules, the Customer must pay the relative fee at least 15 days before the 
current license expires; if the deadline is not respected, NextFEM SRLS can’t guarantee such continuity, and the licensed mod ules 
may be blocked. For no reason the payment of the annual fee regarding the software and/or its single component module and/or 
required services can be delayed or suspended; eventual exceptions or Customer's disputes will be managed and solved 
separately. 
 
3. NextFEM SRLS provides software updates for 12 (twelve) months starting from the delivery date, limited to the functionalities of 
paid module/s. During this period, encountered malfunctions in paid modules will be fixed to ensure the correct functionality. This 
guarantee does not apply to functionalities not included in the paid modules. 
 
Art. 9 – Warranty and liability – 
 
1. For both the basic software version and the paid modules, NextFEM SRLS provides the software “as is” and it is not obliged  to 
provide maintenance, support, updates, improvements or changes. During the  validity of this agreement, eventual software 
updates or patches may be released. 
 
2. NextFEM SRLS is committed, only for functionalities of the paid modules, and for 12 months from the purchase, to keep the 
software able to perform the tasks described in the user manual. During this period, encountered malfunctions of the paid modules 
will be fixed to ensure the correct functionality. This guarantee does not apply to functionalities not included in paid modules, nor 
to Educational licenses, as stated in art. 14 of this agreement. 
 
3. The warranty is conditioned to the correct original functioning of the Client’s machine, hardware and system software and the 
existence of the minimum requirements prescribed for the correct software installation, as well to the circumstances in which the 
Customer installs the updates and patches that can be made available by the Licensor via an independent download made from 
the nextfem.it website, and also to the correct use of the system and software by the Customer. 
 
4. The Customer is the sole responsible for the choice of the software produced by NextFEM SRLS and its compliance to his own 
needs and purpose of use, for any input fed to the software and any output coming from the program or from its parts, and must 
verify results, reports and the checks conducted with it. 
 
5. The software provided by NextFEM SRLS are a representation of the current state of development, so NextFEM SRLS cannot 
grant that they will always work correctly in every applications and in any situation. 
 
6. Customer is responsible of installation, launch, and usage of the software produced by NextFEM SRLS and of the application of 
the related updates and patches, their transfer to the computer, the settings, and everything not explicitly stated in this Contract 
that burden on NextFEM SRLS. 
 
7. This warranty is not valid whenever a software fault is due to accident, improper and/or non-conforming and/or wrongful usage. 
Any change to the software made directly by the Customer will result in the withdrawal of this warranty. 
 
8. NextFEM SRLS does not take any responsibility and is not liable for any direct and/or indirect, special, collateral, incidental and/or 
consequential damage, including lost profits, incurred by the Customer or third parts caused through the use or lack of use of the 
software and by any means related and/or consequential to eventual software quality, adequacy, use and usability flaws, which 
are therefore to be exclusively borne by the Customer, except as what is compulsorily required by law. 
 
9.  NextFEM SRLS does not take any responsibility and is not liable for any direct and/or indirect, special, collateral, incidental and/or 
consequential damage, including lost profits, incurred by the Customer or third parts caused through the use or lack of use of the 
software and by any means related and/or consequential to eventual software quality, adequacy, use and usability, caused by 
suppliers or by parts of program developed by third parts. To these parts of programs developed by third parts are applied their 
own licensing conditions, which can be found inside NextFEM SRLS software from ? / Information …. 
 
Art. 10 – Software restitution -  Software deletion – 
 
1. Within one month from the termination of this agreement for any reason, the Customer must delete and eliminate any copy of 
the software he owns, even if they are backup copies. The Customer must confirm this by sending to NextFEM SRLS an e-mail 
within the same deadline. 
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2. As a consequence of the termination of this agreement as in the previous subparagraph, the license of use is revoked and cannot 
be use anymore by the Customer for any purpose. 
 
Art. 11 – Support and/or consultation - 
 
1. Upon Customer's request, NextFEM SRLS is willing to give, by a preventive stipulation of specific separate contracts, the 
necessary support and/or consultation to maintain or launch or update or personalize or implement the software provided by 
NextFEM SRLS, also for a potential training of Customer's staff who is appointed for its use. 
 
2. The possible existence of other contractual relationships between NextFEM SRLS and the Customer does not affect other 
connections between them, that will remain separated and independent. 
 
3. The free licenses of use granted by NextFEM SRLS (i.e. basic program, Educational license, etc.) are not covered by any kind of 
support. 
 
4. The paid licenses of use granted by NextFEM SRLS to the Customer can be issued with a first-installation assistance via email, 
until 7 days after the payment. Further paid support can be supplied for one year starting from the license acquisition. Support 
period can be bought or renewed only together with the program license or renewal, respectively. Assistance is supplied only via 
email and concerns the sole software use or program functioning. NextFEM SRLS does not supply support on the engineering 
choices made or to be made for designing any structures. Any advice given by support cannot substitute the engineering 
judgement of the Customer, who is the sole responsible of the structure designed, analysed and checked with the program, 
including the obtained results. 
 
Art. 12 – Communication - 
 
1. Any communication from one part to another of this agreement must be sent as a registered letter with signed return receipt or 
as a hand-delivered registered letter addresses to “NextFEM SRLS, Piazza del Foro Romano 12, 31046 Oderzo (TV)” or as a certif ied 
e-mail to nextfem@pec.nextfem.it. 
 
Art. 13 – Litigation – Applied law - 
 
1. This contract is subjected to the Italian law. 
 
2. Any litigation in any case connected to this agreement shall be exclusively of the competence of the Court of Treviso. 
 
Art. 14 – Educational license – 
 
1. Educational licenses are distributed for a predetermined number of PCs prior oral or written agreement with NextFEM SRLS. 
NextFEM SRLS solely decides the number of distributed licenses prior consultation with the Customer. 
 
2. Educational licenses can be given freely to a private or public Customer, when it is a training institution, a research and 
development company or a school, at the incontestable discretion of NextFEM SRLS. In such case, the given Educational licenses 
do not grant to the Customer the right to use them after the planned time period conceded to the Licensee, and they can be 
revoked at any time by NextFEM SRLS without any justification or notice to the Customer. 
 
3. When given freely, Educational license does not allow for any refund of the cost of the software, for any reason. 
 
4. When given freely, Educational license does not allow for any kind of support supplied by NextFEM SRLS, neither for 
malfunctioning of the program. Hence, the warranties described in art. 9, paragraph 2 of this agreement are excluded. 
 
Art. 15 – Changes of terms in this agreement –  
 
1. The Licensor has the right to modify the conditions of the present License user’s agreement for the software of NextFEM SR LS 
by email to be sent to the Licensee to the address given during registration on nextfem.it website. The Licensee has the right of 
withdrawal by sending a registered letter with signed return receipt or as a hand-delivered registered letter addresses to “NextFEM 
SRLS, Piazza del Foro Romano 12, 31046 Oderzo (TV)” or as a certified e -mail to nextfem@pec.nextfem.it compulsorily within 14 
days from the receipt of the communication related to the changes of the agreement terms. 
 
Art. 16 – Final provisions -   
 
1. Whenever one of the clauses contained in this Contract will be declared invalid or without effects, entirely or in part, this will not 
invalidate the other clauses, except when the Licensor considers in bona fide the clause as essential, and consequently shall ask 
for the resolution of the contract. 
 
2. For anything not expressively provided in this contract, the Italian Civil Code rules shall be applied and the Legislative Decree of 
29th of December 1992, n. 518  as amended and supplemented, regarding the implementation of the Council Directive n. 91/250 
CEE of 14th of May 1991 on the legal protection of computer programs which modifies and integrates Law 22nd of April 1941, n. 
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633, and this last law as amended and supplemented, and the Directive  2009/24/EC of the European Parliament and the Council 
of  23rd of April 2009  as amended and supplemented. 
 
Oderzo (TV),  (date of acceptance of this contractual conditions) 
 
NextFEM SRLS                       Licensee                                                                                                                                  
 
Pursuant to and in accordance with art. 1341 and 1342 c.c., the Customer specifically approves, for having them read, understood 
and known, the articles: 2 (Duration – Agreement termination) paragraph 2, 3 (License delivery) paragraph 3, 4 (Installation) 
paragraph 3, 5 (Programs usage), 6 (Property – Transfer prohibition), 7 (Right holders – Secret – Modifications) paragraph 2, 8 (Fee 
– Solve et repete) paragraph 2, 9 (Warranty and liability) paragraphs 3,4,5,6,7,8,9, 10 (Software restitution -  Software deletion) 
paragraph 4, 11 (Support and/or consultation), 13 (Litigation – Applied law), 14 (Educational license) paragraphs 2 and 3, 15 
(Changes of terms in this agreement), 16 (Final provisions). 
 
Oderzo (TV),  (date of acceptance of this contractual conditions) 
 
The Customer 
 
 
This software is copyright of NextFEM, 2014-2024. 
Windows® is a registered trademark of Microsoft Corporation. Other trademarks belong to their respective owners. 
 
 

NextFEM Designer uses: 

OOFEM v.2.6 
ZedGraph Library v.5.1 
Clipper2 Library v.1.0.6 
netDxf Library v.3.0.1 
Poly2Tri Library 
RichTextBoxLinks Library 
SlimDX Library 
Sonic Library 
UnitConversionLib Library 
DotNetZip Library v1.13.7 
Triangle.NET Library Beta 4 
Netgen Library v.6.0 
with OpenCascade Libraries 
PDFSharp v.1.32 
RTFWriter Library v.1.0 
xBIM Essentials v.6.0 
xBIM Geometry v.5.1 
xBIM GLTF v.5.1 
XbimWebUI for xBIM Toolkit 
Desktop Bridge Helpers v.1.1.0 
DocX Library v.1.0.0.22 
Splicer Library v.1.0 
DirectShowLib v.2.1 
OpenStreetMap site 
IDEA StatiCa IOM 
Newtonsoft Json.NET v12.0 
AutoUpdater.NET v1.1 
SdxSpriteTextRenderer v2.0 
RibbonWinforms v5.0.1.0 
glTF-CSharp-Loader v1.1.3-alpha 
SpreadsheetLight v3.5 
WPF-Math v0.11 
Collapsible control 
OpenTK library 
WeifenLuo.WinFormsUI.Docking library 
LiteDB Library 

 

All the licenses, including the general one for the program and for paid modules, can be found in the dialog ?/About 

…  . 
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